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1. About

1.1. Purpose of the document

This document contains detailed information about UAS data processing in the PHO-
TOMOD UAS program. The document contains recommendations of processing order,
program properties to obtain the best results, and also contains description of additional
possibilities when working with UAS data.

1.2. Purpose and main definitions

The PHOTOMOD UAS program is purposed to process data from unmanned aircraft
system (UAS). There is a limit on using of the source data when working with program.

Only central projection images with size not more than 80 Mpix could be used a source data.

The following definitions for UAS projects processing are provided in the program:

• preliminary preparing of source images;

• images interior orientation;

• relative orientation of images;

• input and measurement of GCP coordinates;

• Images exterior orientation;

• vectorization;

• stereovectorization;

• building DEM;

• creating orthomosaic;

• creating digital map;

• creating 3d-models.

1.3. Technical Support

The Racurs company technical support provides the actual information about system
functionality, characteristics, price and services.

For technical support use one of the following ways:
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• e-mail: support@racurs.ru;

• phone: (495) 720-5127;

• fax: (495) 720-5128;

• mail: RACURS Co., Ul. Yaroslavskaya, 13-A, office 15, Moscow, Russia;

1.4. Distribution kit

The PHOTOMOD UAS program is a stand-alone software, which does not require the
PHOTOMOD system installation. Also the program could be launched as a module of
the PHOTOMOD system.

License software distribute in a branded box.

The company name is place on the front. On the reverse side are placed address,
technical support service phone and e-mail, web-site of company.

The system distribution kit includes:

• CD-ROM containing the system setup files and the documentation files in PDF format;

• ’System installation Manual’;

• Hardware lock key (see Section 2).

2. Sentinel hard lock key
The distribution kit includes the unique hard lock key from Sentinel HL (previous called
HASP), to protect the system and data from software piracy and unauthorized dissem-
ination.

The Sentinel HL hard lock key is produced by SAFENET company (www.safenet-inc.com).

If the Sentinel HL hard lock key not found, the error message of protection system dis-
plays. Contact the Racurs company technical support service (see Section 1.3) to for
the consultation.

To check congruity of hard lock key perform the following:

1. Choose License info in the right-click menu of the System Monitor module (the
icon in the Windows system tray). Process of licences checking starts. After
checking, the PHOTOMOD Distribution info windows opens.
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Fig. 1. Distribution Info

2. Compare the unique number of security key in the Serial number line with the
number on hard lock key.

3. Compare quantity of license for modules in each line below the name of module.
Quantity of licence in the hard lock key and in Certificate should be equal.

’h’ is quantity of licence in the hard lock key.

4. If number are not equal contact the RACURS company technical support service.

To use local system version, security key should be installed on a stand alone worksta-
tion. During the installation drivers of security key are installed automatically.

In case of problems with installation of security key drivers, install it manually. To do
this open theHasp\Sentinel_HASP_Run-time_setup folder from the installation CD and
launch the HASPUserSetup.exe file. Install security key with default parameters.

It is recommended to install the security key on computer which is not used to project processing,
recording CD/DVD, etc.

If there is not enough RAM or resource-intensive tasks are performed on workstation with the
secure key, The protection system failure or loss of data are possible.

3. System installation
Prior to the system installation, the unique security key from Sentinel HL should be in-
stalled on the workstation.
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The system required 2 GB of free hard disk space.

To start the system installation, launch the setup.exe file or input the installation software
and launch the autorun.exe file.

Click Install › PHOTOMODUAS. The Installation PHOTOMOD 6 UASwindow opens.

The system initial installation process consists of a sequence of steps with instructions.

In case of cancel at any step, installed program files and data are not removed. To complete
the system installation, restart the autorun.exe or setup.exe file and go through all steps again.

The system installation process consists of the following steps:

Preparation step

1. Read the welcome and warning messages. Click the Next button.

2. Read the license agreement. If you agree with it, set the I accept the terms in the
License Agreement checkbox on and click the Next button.
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3. Define the folder to install the program files of the system. Click the Next button.

It is strongly not recommended to install the system in folder with name, which contains
letters, different from Latin. By default for the program files the C:\Program Files\ PHOTO-
MOD 6 UAS is used for 64-bit operation system and C:\Program Files (x86)\ PHOTOMOD
6 UAS – for 32-bit OS.
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4. Enter a folder name for the PHOTOMOD programs and modules in the Windows
Start menu.

The Create shortcuts on Windows desktop launch automatically the System
Monitor module at Windows start checkboxes are set on by default.

5. Click the Next button.

File copy stage

1. Click the Next button to start installation.

2. When installation complete, click the Finish button and proceed to the system
configuration stage.
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If the security key was not found, the error message displays. Install the security key and
restart the system.

If the Sentinel HL hard lock key and filed PhConsts50.dll do not congruity, the error mes-
sage from protection system displays. To obtain the licence file contact the Racurs company
technical support service (seeSection 1.3). After obtain the licence file copy it to the system
folder (by default C:\Program Files\ PHOTOMOD 6 UAS) and launch the system.

System configuration stage

1. During the first launch of the system the PHOTOMOD UAS initial setup window is
also opens.

Fig. 2. Choosing a folder to store the projects

2. Click the button to select a physical folder on a local PC to store the PHOTO-
MOD UAS projects.

3. Click OK to finish system configuration and create the local profile automatically.
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The Control Panel module is used to configure detailed system settings during the further
work. More details about program resources, recommendations on organizing of local or
network work, and about creating profiles and virtual folders connecting see in the “Prepare
to processing” chapter of the “General information” User Manual.

System deinstallation

To remove the system from computer, close all modules of the system and choose
Start › Programs › PHOTOMOD 6 UAS › Uninstall PHOTOMODUAS or use standard
tools in Control panel of Windows file system.

4. Start of work
Define the folder, in which are placed the sources data before the beginning work in
the program. The program allows to place the files with the source data in the folders
of Windows file system, as well as in the profile resources.

To start the program perform one of the following:

• in the context menu of SystemMonitor module (the icon in the system tray) choose
the PHOTOMOD UAS;

• choose the Start › Programs › PHOTOMOD6 › PHOTOMOD UAS.

5. Input data
During the project creation, aerial triangulation and block adjustment the following source
data is used:

• [optional] The list of GCP coordinates is necessary for block adjustment. The system
provides opportunity to measure GCP coordinatesmanually and also to perform import
of GCP list from a text file.

• [optional] The list of projection centers coordinates to process central projection im-
ages. The program also provides the ability to import on-board data (coordinates)
about projection centers from CSV files.

Block adjustment could be process only by projection centers without using ground control
points. It is recommended to use GCP coordinates to increase adjustment accuracy.

• Raster images

For working with images in program , it is recommended to use MS-TIFF internal
raster format, which is the TIFF format with overview pyramid (set of subsampled
images copies) for higher image display performance.
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The Raster Converter module is used to preliminary raster image processing. It is
possible to convert image into internal format both manually, before creating project,
and on the stage of adding images into project with saving converted images into
active profile resources. See theRaster Converter module description in the “General
information” User Manual.

The following image formats are available to process central projection images:

○ JPEG (JPEG);

○ Tag Image File Format (TIFF) TIFF и GeoTiff format, included tags for saving of
georeference information;

○ Windows Bitmap File (BMP);

○ Advanced Systems Format (ASF).

• Information about coordinate system and map projection – during project creation it
is necessary to define coordinate system of GC points. By default there is an Interna-
tional coordinate system database and map projection (see the details in the “Geo-
Calculator” User Manual);

• also it is possible to use the following exterior data:

○ import of triangulation points from PAT-B and X-POINTS;

○ import of ground control points from text files *.txt and *.csv (see above The list
of GCP coordinates);

○ import of interior and exterior orientation data from metadata;

○ import of external orientation data from PAT-B and CSV-files (see above The list
of projection centers);

○ GPS data;

○ import additional data from different formats.

6. Output data
The program allows to process UAS data and acquire all types of value added photo-
grammetric products: DEM, 2D and 3D-vectors, orthomosaics.

There are the main output products:

• Digital Terrain Model (DTM) – digital cartographic presentation of terrain surface both
as regular grid of elevations (DEM) and as triangulated irregular network (TIN). They
are used for solving applied research problems.
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• 3D vector objects – used for creating a topographical base for cartographic production
or as source data for a mathematical representation of a scene in three-dimensional
digital terrain modeling;

• orthophoto production – single raster images in the form of a single frame or a set of
sheets in a selected map projection with marginalia. In the resulting image, geometric
and photometric distortions are corrected, creating seamless, color-balanced ortho-
photos with uniform brightness as an output;

• 3D models of terrain – can be used to solve applied research problems, as well as
for creation of multimedia presentations and commercials.

There is opportunity to export all photogrammetric products to various formats.

7. Interface and its elements

7.1. Work area interface

The GUI contains the following elements:

• the main menu, which contained the all program functionality (A);

• the main toolbar is used for quick access to main program functions and also contains
Aerial Triangulation, Compute DEM and Compute Orthophoto tabs (B). The tabs
layout and content displays the main steps of UAS data processing workflow;

• the optional toolbars is used for quick miscellaneous program functions access (O);

Toolbars could be placed only one-lined, horizontal or vertical.

• the 2D-window, used for data displaying, contains the following elements:

○ the toolbar is used for the 2D-window modes managing (C);

○ the work area is used for viewing and processing with loaded data of mosaic project
(F);

○ the navigation bar is used for fast moving on the specified block images area of
mosaic project (D);

By default on launch of the program layers are not shown in the navigation window. If ne-
cessary, click the Navi tab and choose layers to display.

○ the Layer manager is used for managing of project layers (E);
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○ the axes direction of project coordinate system (M);

○ the status bar is used for viewing current real (ground) and pixel marker coordinates
and brightness, contrast and gamma data adjustment in the work area (G, K, L).

When place marker is on the area out of image or on background, brightness is indicated
as NULL.

Fig. 3. The main program’s window

7.2. Brief description of main menu

The program main menu contains the menu items for mosaic creation, vector data
processing, additional applications starting and setting parameters.

Table 1. Main menu

FunctionMenu
contains menu items to create, open, save and
convert project, and also to get an information about
project

Project
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FunctionMenu
allows to form images block of mosaic projectBlock
contains menu items to interior orientation, load and
use ground control and triangulation points, exterior

Orientation

orientation parameters and also to import and export
triangulation points for various formats
allows to create, open and save regular nodes grid
(see the “Create DTM” User Manual)

Grid

contains Points, TIN, DEM, Contours and LAS
submenus

Terrain

purposed for creating, editing, import/export of vec-
tor data (see the “Vectorization” User Manual)

Vectors

allows to load and georeference raster images, and
also to launch additional modules for editing and

Rasters

orthorectification images (see the “Orthophotomaps
creation” User Manual)
allows to launch applications, load additional data,
set general parameters and edit coordinate systems

Service

(see the “General information about system” User
Manual)
allows to open additional toolbars and windows (new
2D-window, Marker and Measurements windows,
window of Object Attributes)

Window

allows to start the “Help” systemHelp

7.3. The main toolbar

The main toolbar is used for quick access to main program functions and also contains
Aerial Triangulation,Compute DEM andCompute Orthophoto tabs. The tabs layout
and content displays the main steps of UAS data processing workflow;

Table 2. Brief description of main toolbar

FunctionButtons
allows to open block editor window (see the ’Project
creation’ User Manual)
allows to reload project to display the last saved
version of project
allows to perform import of exterior orientation from
metadata
allows to open block layout window (see the ’Aerial
triangulation’ User Manual)
allows to open block editor window (see the ’Project
creation’ User Manual)
allows to display all images, loaded to project, in
the Block scheme window
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FunctionButtons
allows to display only selected on scheme images
in the Block scheme window
allows to load triangulation points
allows to open 2D-window for selected stereopair
(see the ’Vectorization’ User Manual)
allows to launch theDustCorrect module to edit MS-
TIFF images (see the Project creation User Manual)
allows to run the GIS Panorama Mini
allows to launch the 3D-mod module
allows to create, open and save regular nodes grid
(see the ’Create DTM’ User Manual)
allows to load vector file into the project (see the
’Vectorization’ User Manual)
allows to load DEM file
allows to load georeferenced raster image to project
as a layer
allows to load web-map
allows to undo the last action (see the ’General
system’s parameters’ User Manual)
allows to display the list of last actions (see the
’General information about system’ User Manual)
allows to redo the last undone action (see the
’General system’s parameters’ User Manual)
allows to open the Marker window (see the menu
description in ’Vectorization’ User Manual)
allows to open theMeasurementswindow (see the
menu description in ’Vectorization’ User Manual)
allows to tile 2D-windows
allows to stack 2D-windows
allows to refresh all opened 2D-windows
allows to open the general program parameters
window (see the ’General system’s parameters’
User Manual)

Table 3. Brief description of the “Triangulation” tab of the main toolbar

FunctionButtons
is used for adding image files, locating in the re-
sources out of active profile, to the selected strip

From files

is used for adding image files, locating in the re-
sources of active profile, to the selected strip

From resources

allows to perform import of exterior orientation and
interior orientation results

Import from metadata

allows to input/edit parameters of project cameras,
and also to assign cameras to project images

Cameras
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FunctionButtons
allows to perform import of exterior orientation data
from file of text format

Import from file

allows to open exterior orientation data listExterior orientation data list
allows to setup and start аutomatic tie points
measurement using UAS data

Automeasure tie points

allows to open tie points list (see the “Aerial trian-
gulation” User Manual)

Tie points list

allows to perform import of ground control points
from *.txt and *.csv files

Import catalog

allows to open GCP list (see the “Aerial triangula-
tion” User Manual)

GCP list

allows to open the adjustment toolbarBlock adjustment
allows to perform adjustment using imported exterior
orientation parameters

Direct georeferencing

Table 4. Brief description of the “Compute DEM” tab of the main toolbar

FunctionButtons
allows to start automatic points calculationCompute points
allows to launch the buildings and vegetation filter
for points

Buildings and vegetation filter

allows to build TIN by points and breaklines (Ctrl+N,
T)

Build TIN

allows to build DEM by loaded TIN (Ctrl+N, D)Build from TIN
allows to create contour lines by DEMBuild contours
allows Создание to build dense DEM using SGM
method

Dense model

allows to launch the buildings and vegetation filter
for DEM

Buildings and vegetation filter

allows to Создание restore null cells of DEM using
the smooth interpolation method

Fill NULL cells

Table 5. Brief description of the “Compute Orthophoto” tab of the main toolbar

FunctionButtons
allows to display the orthorectification toolbar
(Ctrl+Alt+M) (see the Orthomosaic building User
Manual)

Оrthorectification

allows to start PHOTOMOD GeoMosaic program
(see the The Orthophotomaps creation User
Manual)

Start GeoMosaic

7.4. The “Block” menu

The Block menu, buttons of Block editor window’s toolbar and Block forming addi-
tional toolbar are used to work with images block in 2D-window.
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It includes extended features for images block forming, as well as additional functions
for block scheme creation and obtaining of auxiliary data.

Some menu items allow to manage operations with selected images in 2D-window.
The Tools additional toolbar is used for group selection (highlighting) of images block
in 2D-window (see the “Vectorization” User Manual).

Detailed information aboutBlockmenu items, buttons ofBlock editorwindow’s toolbar
and Block forming additional toolbar see in the “Project creation” User Manual.

Table 6. Brief description of the “Block” menu

FunctionMenu items
allows to add image files, locating in the resources
out of active profile, to the selected strip

Add images from files

allows to add image files, locating in the resources
of active profile, to the selected strip

Add images from resources

allows to automatically add images from specified
folder of active profile resources to selected strip,
with or without its subfolders

Add images from resource folder

contains menu items used to split images block to
strips automatically using images names or exterior
orientation parameters

Split to strips

allows to open the Block editor windowBlock editor (Ctrl+Alt+B)
allows to open the Block layout window to build
block scheme in 2D-window considering source or

Block layout (Ctrl+Alt+L)

acquired data (see the Aerial triangulation User
Manual)
allows to create map of images and/or strips overlap
in new vector layer (see Section 20.1)

Create overlap map...

contains the Additional menuAdditional

Table 7. Brief description of the “Block” menu (Additional)

FunctionMenu items
allows to add new stripAdd strip
allows to delete selected strips of block in 2D-win-
dow

Delete strip

used to view and edit properties of selected strips –
strip’s name and type (regular or irregular)

Strip properties

allows to invert strips orderInvert image order in strip
allows to move selected strips to the beginningSelected strips to block start
allows to move selected strips to the endSelected strips to block end
allows to add new stripAdd strip
allows to delete selected strips of block in 2D-win-
dow

Delete strip

18

Processing of UAS dataPHOTOMOD 6.4

vectorization.pdf
project.pdf
measurement.pdf


FunctionMenu items
used to view and edit properties of selected strips –
strip’s name and type (regular or irregular)

Strip properties

allows to move selected strips one strip upMove selected strips up
allows to move selected strips one strip downMove selected strips down
allows to change regular strip to irregularMake selected strips irregular
allows to change irregular strip to regularMake selected strips regular
allows to remove selected images from projectDelete images
allows to select images in accordance with specified
criteria for deleting (see Section 20.2)

Delete images selectively...

is used to display and edit properties of selected
image

Image properties

opens a group of menu items used to images block
editing; allows to invert images order in a strip, and
to move selected image left/right/up/down

Move images

allows to perform radiometric correction of selected
image (see in the Project creation User Manual)

Image radiometric correction

allows to show images of block in 2D-window if the
limitation on images display is specified on the

Show images

Block scheme | Raster tab in the Settingswindow
(see “General information” User Manual)
allows to turn on/of selected images displayShow selected images only
allows to check images, for example, to find images,
where radiometric correction is recommended

Check images

allows to exclude project images validation - check
their presence and compliance to images files during
project opening at the next working session

Mark all images as checked

allows to movemarker to center of the image, selec-
ted in the list of the Block editor window

Market to selected image

allows to rotate selected images at any angle relat-
ively to initial or current position of block images

Rotate selected images

allows to rotate all or selected images of block con-
sidering block layout data; images don’t rotate if the

Rotate images by block layout

w\o layout was used (see the “Aerial triangulation”
User Manual)
allows to define/calculate GSD value in meters for
all or selected images of block

Set GSD for selected images

allows to create vector layers with common block
outline, boundaries of all images or selected image
of the block

Create vector layer from block layout

allows to create pre-regions by images/stereopairs
to provide joint work on a project

Build pre-regions

allows to export block scheme to KML formatExport block layout to KML...
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7.5. The “Orientation” menu

To perform work on data collection for aerial triangulation serves theOrientationmenu,
and also buttons of the main toolbar and of the AT additional toolbar.

Table 8. Brief description of the “Orientation” menu

FunctionMenu items
allows to input/edit parameters of project cameras,
and also to assign cameras to project images

Manage projects cameras (Ctrl+Alt+I)

allows to perform import of exterior orientation res-
ults

Import orientation from metadata...

allows to open the Exterior orientation data listImport exterior orientation
contains menu items used to measure tie points
coordinates in automatic mode

Automatic tie points measurements

allows to open catalogue of all tie points with their
measurements (see “The “Triangulation points”

Tie points list (Ctrl+Alt+T)

window” chapter of the “Aerial triangulation” User
Manual)
allows to open catalogue of all ground control points,
including non-measured on block images (see the

GCP list (Ctrl+Alt+G)

“GCP list” chapter of the “Aerial triangulation” User
Manual)
allows to open the adjustment module, to view ad-
justment results and errors correction (see the
“Block adjustment” User Manual)

Block adjustment (Ctrl+Alt+S)

allows to perform adjustment using imported exterior
orientation parameters

Direct georeferecing

allows to create the processing reportProcessing report
allows to delete adjustment data (see the “Block
adjustment” User Manual)

Delete adjustment results

contains the Additional menuAdditional

Table 9. Brief description of the “Orientation” menu (Additional)

FunctionMenu items
allows to open a report about interior orientation
results (see the Aerial triangulation User Manual)

Report on interior orientation

[only for film camera images] allows to measure
manually coordinates of fiducial marks on images
(see the Aerial triangulation User Manual)

Manual interior orientation

[only for film camera images] allows to perform
semiautomatic interior orientation, which is to use

Semiautomatic interior orientation

image-standard with template of fiducial marks pos-
ition used to search the same fiducial marks on
other project images (see the Aerial triangulation
User Manual)
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FunctionMenu items
[only for film camera images] is used to perform
automatic interior orientation, which is the automatic

Automatic interior orientation

recognition of fiducial marks by their type, peculiar
to certain analog camera images (see the Aerial
triangulation User Manual)
allows to re-calculate interior orientation parametersCalculate interior orientation
allows to open the Select images window that is
used to delete results of fiducial marks measure-
ments on selected images

Delete interior orientation data

contains menu items used to perform quick ties in
order to use the data for block layout creation (see
the “Aerial triangulation” User Manual)

Quick Ties

allows to open the Points measurement module
used tomeasure points coordinates in manual mode

Open selected images for measurements

on images selectedin 2D-window (see the “Aerial
triangulation” User Manual)
allows to open the Points measurement module
used tomeasure points coordinates in manual mode

Open images containing marker (Ctrl+Alt+K)

on images, that contain marker position in 2D-win-
dow
allows to open the Points measurement module
used tomeasure points coordinates in manual mode
on selected in-strip stereopair in 2D-window

Open in-strip stereopair

allows to open the Points measurement module
used tomeasure points coordinates in manual mode
on selected in 2D-window inter-strip stereopair

Open inter-strip stereopair

allows to open the report with results of images rel-
ative orientation in order to perform analysis and
removal of errors in tie points measurements

Report on relative orientation (Ctrl+Alt+R)

allows to choose types of triangulation points to be
deleted and delete them

Delete point measurements

allows to remove the whole list of triangulation points
(GCP, check, tie) from triangulation points catalogue

Clear point catalogue

allows to loadmeasured coordinates of triangulation
points to 2D-window with possibility to setup of dis-

Load triangulation points

play of certain type of points (see the Aerial triangu-
lation User Manual)
allows to delete points out of useful areas (with
specified background color) (used mainly during

Delete points outside useful areas

automatic points measurements on spaceborne
images)
contains menu items used to import of triangulation
points measurements from files of PAT-B, X-Points

Import

formats from PHOTOMOD 4.x (XPT) projects, as
well as data import from flight path file (see the
Aerial triangulation User Manual)
contains menu items used to export of triangulation
points measurements to files of PAT-B and X-Points

Export
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FunctionMenu items
formats, and for export of ties or GCP for further
use them in Geomosaic module (see the Aerial tri-
angulation User Manual)
allows to open the Exterior orientation data listList of exterior orientation parameters
allows to perform export of list of source exterior
orientation parameters and adjustment results to
PAT-B and CSV formats

Export exterior orientation...

allows to load projection centres data as vector point
objects and to open them in 2D-window to perform

Load projection centres as vectors

analysis, at that an image name is saved to the Name
point attribute
allows to perform export of georeference data after
preliminary block exterior orientation and adjustment

Create images georeferencing files

(to files of ArcInfo World Fileand MapInfo
TABformats)
allows to select part of block images to perform ad-
justment

Select subblock

allows to specify adjustment parameters and to
perform block adjustment without using the the Ad-

Adjustment in batch mode

justment toolbar (see the “Block adjustment” User
Manual)

7.6. The “DEM” menu

The Terrain menu contains Points, TIN, DEM and Contours submenus.

Table 10. Brief description of the “Terrain” menu

FunctionMenu items
The Points menu contains usual menu items used
for automatic points measurement, filtering, import

Points

and export (see the “Points” chapter of the “Creating
DTM” User Manual).
The TIN menu contains menu items used to load
and save TIN layers, as well as to perform different

TIN

operations on creation, editing and accuracy control
of TIN building (see the “Triangulation irregular
network” chapter of the “Creating DTM” User
Manual).
TheDEMmenu contains standardmenu items used
to load and save DEM layers, as well as menu items

DEM

used to perform various operations on DEM cre-
ation, accuracy control, filtering and editing.
The Contours menu contains usual menu items
used for contours generating, editing, import and
export.

Contours

The LASmenu contains usual menu items used for
converting the LIDAR data to DEM which is saved

LAS
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FunctionMenu items
into the file of active profile (see the “LIDAR Data
processing” User Manual)

7.7. The “Windows” menu
Table 11. Brief description of the ’ Windows ’ menu

FunctionMenu items
allows to open window with a block schemeNew 2D-window (block)
allows to open window with a stereopairNew 2D-window (stereopair) (Ctrl+Alt+W)
allows to open the 3D-window (see the ’General in-
formation’ User Manual)

3D-window

allows to open marker parameters window (see the
’Vectorization’ User Manual)

Marker window (Ctrl+Alt+C)

allows to open window that allows to perform
measurements by images (see the ’Vectorization’
User Manual)

Measurements window (Ctrl+Alt+D)

allows to open the Classifier window to show set
of standard vector objects attributes (see the Clas-
sifier chapter in the ’Vectorization’ User Manual)

Classifier

allows to open the Attributes window to display at-
tributes of selected vector objects (see the Vector

Objects attributes

objects attributes chapter in the ’Vectorization’ User
Manual)
contains menu items allows to open additional tool-
bars

Toolbars

contains the Additional menuAdditional

See detailed description of the system’s windows in the “General information about the system”
User Manual.

To get quick access to themainwindows of the system, selectWindows › Toolbars › Windows.
TheWindows toolbar is opened.

Table 12. Brief description of the ’ Windows ’ menu (Additional)

FunctionMenu items
allows to show all toolbarsShow all toolbars
allows to show all opened toolbars in visible part of
the screen

Find all toolbars

allows to hide/show all opened toolbarsTemporarily hide toolbars (TAB)
allows to open the Images list window (see the
’Creating project’ User Manual)

Image list...

allows to open window with image selected on a
block scheme

New 2D-window (single image)

allows to open all 2D-windows with marker place.
Press and holdAlt key while clicking the menu item

Open image under marker
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FunctionMenu items
to open images with 1:1 zoom , otherwise, full im-
ages are displayed
allows to close all 2D-windows with imagesClose all single image windows
allows to refresh information in all opened 2D-win-
dows

Refresh all 2D-windows

contains menu items allow to arrange opened 2D-
windows in a work area with one of the following
ways:

Arrange

• Tile (also on the main toolbar) – allows to tile
2D-windows;

• Row – allows to row 2D-windows;

• Column – allows to column 2D-windows;

• Stack (also in the main toolbar) – allows to
stack 2D-windows.

contains menu items allows to move to other stereo-
pairs (see the ’Vectorization’ User Manual)

Stereopairs

allows to show table with triangulation points coordin-
ates

Triangulation points coordinates

allows to choose triangulation points to displayTriangulation points view control
allows to open contours classifier window to edit
parameters of contours display (see the ’DTM gen-
eration’ User Manual)

Contours classifier table

allows to display list of active layer vector objects
(see the ’Vectorization’ User Manual)

Objects list

allows to set on the mode allows to move marker in
stereopair 2D-window in pixel coordinates

Marker motion in pixel coordinates

allows to zoom in all 2D-windowsZoom all in (Shift+* NumPad)
allows to zoom out all 2D-windowsZoom all out (Shift+/ NumPad)
allows to use a view mask for active layer (see the
’General information’ User Manual)

Layer view mask

allows to view list of opened 2D-windowsWindows list

7.8. The “Block editor” window

The Block editor window is used to form a block of project images.

TheBlock editorwindow contains a table of created strips and images loaded to project
and contains tools for images block editing.

TheBlock editorwindow is synchronized with 2D-window , so all changes in the images
list of the Block editor (choosing, adding, deleting, moving of strips and images) are
shown in the block scheme in 2D-window and vice versa.
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Choose the Block › Block editor (Ctrl+Alt+B) to open the Block editor window.

Fig. 4. The “Block editor” window

The Block editor window contains the following elements:

• toolbar to form and edit block images;

• the list of existed strips and loaded there images;

• the status bar with the following data:

○ Strip – the Strip name [item No/total] is displayed for strip selected in the table;

○ Image – the Image name [item No/total in strip/total in block] is displayed
for image selected in the table;

○ Font size – allows to change the font size of table text.

To select (highlight) the image in the Block editor window click the image name in the
list. To select strip click on the name of strip.

To select multiple images\strips use Shift and Ctrl keys

To highlight several images in 2D-window use additional toolbar of group selection (see the
Tool section in the “Vectorization” User Manual).

The Block menu items, buttons of the Forming block toolbar and the toolbar of the
Block editor window.

Table 13. The toolbox of “Block editor” window

FunctionButtons
allows to change the Block editor window size so that window displays all list of
strips/images
allows to show/hide the list of strips/images and the status bar to comfort work with block
images in 2D-window (in the Block editor window only toolbar displays)
is used to search for an image by name (part of name)
allows to select in the list initial images, which contain marker position
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FunctionButtons
allows to edit names of several strips of the block at the same time
is used to display and edit properties of selected strip (name and type of strip)
reverse images in the strip order
allows to add new strip
allows to remove selected strip
allows to move selected strip up by one strip
allows to move selected strip down by one strip
is used to display and edit properties of selected image
is used for adding image files, locating in the resources out of active profile, to the selected
strip
is used for adding image files, locating in the resources of active profile, to the selected
strip
allows to remove selected images from project
is used to radiometric correction of selected image
allows to move selected images left/right/up/down, , ,
allows to rotate selected images to any angle in relation to source or current image’s po-
sition in block scheme

allows to open theBlock layoutwindow to build block scheme in 2D-window considering
source or acquired data (see the Aerial triangulation User Manual)

allows to open the ImageWizard window to setup images

allows to show block images in 2D-window, if they were not displayed during project
loading, due to limitation specified in the program’s setting window (see the “General
system’s parameters” User Manual)

allows to set on/off displaying only selected images mode

8. Workflow of UAS processing
Prior to UAS data processing it is necessary to perform the following actions:

• Creating and selecting active profile – creating local profile or creating/connecting
network profile to place all project/project group files – resources, and selecting the
profile as active.

• Creating UAS project.

Processing of data acquired by UAS implies performing the following steps: Aerial
Triangulation, Compute DEM, and Compute Orthophoto.
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Fig. 5. Compute DEM tab of the main toolbar

The content and layout of the Aerial Triangulation, Compute DEM and Compute
Orthophoto tabs of the main toolbar show main steps order of UAS data processing.
The tables below contain grouped links to detailed description of functionality of each
button of these tabs.

Table 14. UAS data processing steps (Triangulation)

From resourcesFrom files1. Add images
CamerasImport from metadata2. Interior orientation
Exterior orientation dataImport from file3. Exterior orientation
Tie points listAutomeasure tie points4. Relative orientation
GCP listImport catalog5. GCP
Direct georeferencingBlock adjustment6. Adjustment

The Tie points list button allows to open Tie points list (see the “Aerial triangulation” User
Manual).

The GCP list button allows to open GCP list (see the “Aerial triangulation” User Manual).

The Direct georeferencing button allows to perform adjustment using imported exterior
orientation parameters.

Table 15. UAS data processing steps (DEM creation)

Dense model7.Compute points7.
Buildings and vegetation filter8.Buildings and vegetation filter8.
Fill NULL cells9.Build TIN9.
Build contours10.Build from TIN10.

Build contours11.

Table 16. UAS data processing steps (Orthomosaic creation)

Orthorectification1. Orthorectification
Start GeoMosaic2. Start GeoMosaic

Depending on tasks to be performed and requirements to output data, the order of UAS data
processing may vary somewhat.
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Fig. 6. Workflow of UAS processing
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Fig. 7. Workflow of UAS processing

29

Processing of UAS dataPHOTOMOD 6.4



9. Creating and choosing active profile
Prior to work in the program you should create a profile for placing project resources
such as project configuration files, images files, files processing projects/project group.

A profile represents a resources tree with the following structure:

• Root – profile virtual name.

• Top level branches – profile virtual folders – virtual names of physical local or network
folders/disks.

You can specify one physical folder/disk or folders/disks group as a virtual folder (storages
group).

Storage folders are a special type of virtual folder. Resources are automatically placed in
storage folders by the program on the basis of free space analysis. Thus, storage folders allow
optimization of multiple disk usage for storage resources, which is advantageous when network
processing large projects.

• Resources – all data of a profile – all subfolders and files of each virtual folder in
profile.

Thus, profile resources are placed on any servers, workstations or network disks.

Profiles can be local or network to organize individual or shared work with projects, re-
spectively.

For profiles creation and organizing resources structure of each profile you can use the
Control Panel module.

To view and edit active profile resources is used the PHOTOMOD Explorer module.

To launch these modules is used the Start › Programms › PHOTOMOD UAS menu
and also the context menu of the System Monitor module (the icon in the Windows
system tray).

More details about program resources, recommendations on organizing of local or
network work, and about creating profiles and virtual folders connecting see in the
“General information” User Manual.

In one work session of the program could be used only one active profile.

Close all program modules an perform one of the following to choose active profile:

• choose active profile in the Profile list from the context menu of the System Monitor
module (the icon in the system tray);
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• choose active profile with mouse double-click by profile name in the Profile list in the
Control Panel.

Current active profile is marked in the profile list by the icon.

Restart program after chosen active profile.

Fig. 8. Creating resources structure of network profile

The folder tree displays in the PHOTOMOD Explorer window after creating profile.

Fig. 9. Resources tree of network profile in the Explorer window PHOTOMOD Explorer

To avoid loss of data, it is not recommended to edit virtual folder for storage group.

10. Project creation
In order to create UAS project perform the following actions:

1. Choose active profile.

2. Start the PHOTOMOD UAS program.
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3. Open the New project window using one of the following ways:

• choose Project › Open/Manage... (Ctrl+Alt+O). The Manage project window
opens. Click the New button;

• choose Project › New.

TheNew projectwindow opens automatically if there is no existed projects in the active
profile.

Fig. 10. Creating UAS project.
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4. Define a Name of new project.

5. [optional] Input to the Description section a brief project description, its main fea-
tures, notes etc.

6. Define a coordinate system using the Select button in the Coordinate system
section.

7. Set on the Relief elevation checkbox and specify at least approximately difference
of terrain heights on project images in the min and max input fields.

If the relief elevation data is unavailable or inaccurate by the time of project creation, the
program allows to define the value later in project properties. The relief elevation data is
used to refine a block layout, it is considered during import of exterior orientation parameters
and during calculation of ground sample distance (GSD).

8. Choose a folder of active profile resources in the Placement list to place a project
resources there. The Full project path input field shows a name and a path of a
project.

9. Click OK to complete a project creation. Service folders and configuration files are
created in specified project folder. The first strip create automatically.

See details about project creation in the “Project creation” User Manual.

11. Add images
Refer to the “Images block forming” chapter of “Project creation” User Manual for the detailed
description of images load from files and resources, images setup and images block editing.

11.1. Image preparing

Prior to load UAS images to a project it is recommended to prepare them using the
Raster Converter module as follows:

1. [if necessary] Perform the radiometric correction.

2. Convert the images to files of inner MS-TIFF format.

3. [optional] It is recommended to apply JPEG compression with 85 % quality for
output files to save place on hard disk.

4. Choose an individual folder of active profile resources in the Placement list to place
a converted images.

See the Raster Converter module description in the “General information” User Manual.
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Fig. 11. Images conversion in the Raster Converter module

11.2. Adding images

Perform the following actions to load images to a project and to form a block:

1. Choose Block › Add images from resources or click the button in the Block
editor window to start images adding.

2. Choose images files and click the Open button. After that all images are loaded to
the first strip.

[optional] To filter showing files choose Image in TIFF format in the list rightward to the
Resources name field.

Refer to the “Images block forming” chapter of “Project creation” User Manual for the detailed
description of images load from files and resources, images setup and images block editing.

12. Interior orientation
Refer to the “Images interior orientation” chapter of “Aerial triangulation” User Manual for the
detailed description of images interior orientation operation.
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Interior orientation operation includes input or import of camera parameters, specifying
of flight direction and angle of camera axes rotation for images of a project.

In order to perform interior orientation when metadata is available, perform the following
actions:

1. Choose Orientation › Import exterior orientation or click the Import from
metadata button on the Aerial Triangulation tab of the main toolbar to get camera
data from EXIF-metadata in image files. The Import orientation from metadata
window opens.

2. Make sure that the Import interior orientation checkbox is set on.

The Import preliminary exterior orientation checkbox is also set by default, in order to
import exterior orientation parameters.

3. [optional] Set Replace existing data checkboxes, if the information about internal
and external orientation has always been imported into the system and data currently
imported is more preferable.

4. Click OK.

Fig. 12. Import orientation parameters from EXIF-metadata

[optional] To check the results of exterior orientation parameters import, perform the
following actions:

1. Choose Orientation › Manage cameras or click the Cameras button on the
Aerial Triangulation tab of the main toolbar to adjust camera parameters and
define camera axes direction for project images. The Manage project cameras
window opens.

2. Choose camera in the list and click the button. The Camera window opens to
view and edit camera data.
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In order to perform interior orientation when metadata is unavailable, perform the follow-
ing actions:

1. Choose Orientation › Manage cameras or click the button of main toolbar to
adjust camera parameters and define camera axes direction for project images.
The Manage project cameras window opens.

2. Choose camera in the list and click the button. The Camera window opens to
view and edit camera data.

3. [optional] Input camera additional data (if camera passport is available) and click
OK.

4. Specify flight direction using window of images preview and define camera axes
rotation for project images in the following way:

1. Choose images in the table which do not require axes rotation.

2. Set the Set camera rotation for selected images checkbox and specify a
rotation angle so, that Х axis coincides with flight direction.

3. Click the Execute button. Interior orientation is performed automatically.

See detailed description of interior orientation step in the “Aerial triangulation” User Manual.

Fig. 13. Performing interior orientation
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13. Exterior orientation
Refer to the “Images exterior orientation” chapter of “Aerial triangulation” User Manual for the
detailed description of images exterior orientation operation.

Exterior orientation parameters are coordinates of projection centres and 3 angles, that
allow to specify in whole real position of images in space.

Exterior orientation parameters may be included to EXIF-metadata of images files or
separately as a catalogue in a file of text format. Additional information about import of
preliminary exterior orientation data from EXIF-metadata is in Section 12.

If exterior orientation parameters are available for UAS project, you can import them to the
project, together with Interior orientation parameters.

In order to perform import of exterior orientation data catalogue from a file of text format,
do the following:

1. Choose Orientation › Additional › Exterior orientation data list or click the
Exterior orientation data list button on the Aerial Triangulation tab of the main
toolbar. The Exterior orientation parameters window opens.

2. Click the button to import exterior orientation parameters.

The button is duplicated by the Import from file button on the Aerial Triangulation
tab of the main toolbar and the Orientation › Import exterior orientation... menu item.

3. Choose a file with exterior orientation parameters and click OK. The Exterior ori-
entation import – Step 1 of 3: File window opens. The File name input field dis-
plays selected file placement and name.

To select another file which contains exterior orientation parameters, click the button.
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Fig. 14. Setup a file string template for import of exterior orientation parameters

4. [optional] If images names in file and in project are not the same, perform one of
the following actions:

• set on the Loose matching of image names in file against names in project
checkbox. The program performs search for common substrings and matches
images names. For example, it searches for common substring 018_02595 in
image name RGBI_018_02595 in file and image name 018_02595 in project.

If the Loose matching of image names in file against names in project checkbox is
set on the image name with file extension is also imported.

• set on the Match by record number checkbox and click the Setup... button.
The Match images by numbers window opens.
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Fig. 15. Images matching by numbers

1. In the Numbers in the file section set the following parameters:

○ Serial numbers of records matching the template – is used to match
a list of records numbers in a file by order;

○ Read from the Name field – is used to match a list of records numbers
in a file by the last number from the filename.

2. In the Numbers of images in the project section set the following paramet-
ers:

○ Serial numbers of images – used to match a list of records numbers in
a project by order;

○ Read from images names – used to match a list of records numbers in
a project by the last number from the filename.

3. Input necessary parameters to the File recordwith the number andmatches
project image with number input fields.

For convenient setup of necessary parameters it is recommended to place windows
in that way that allows to display on screen a name of the first image in the table
of the Exterior orientation parameters window, and also allows to display first
rows in the Preview file table of the Exterior orientation import window. It is re-
commended to place the Match images by numbers window in such a way that
allow to show both windows mentioned above.

5. Choose one of the following formats to specify a type of imported file:

• PAT-B matrix – file containing coordinates of projection centers and rotation
matrices.

• CSV (projection centers, Omega/Phi/Kappa angles and GPS-time) – file
containing coordinates of projection centers in any coordinate system, as well
as exterior orientation parameters, and precise time from GPS-receiver.
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CSV format is exchange text format with *.csv extension, which is supported by major
applications in different industries. It is used as exchange format when special geospatial
data formats are not applicable for some reason.

• CSV (navigation data: latitude/longitude/altitudeWGS-84, heading/pitch/roll
angles and time) – file containing navigation data (latitude/longitude set in de-
grees, altitude in meters, angles in degrees, radians or gons) and precise time
from GPS-receiver.

To perform import of exterior orientation parameters it is necessary that a project is in
coordinate system consistent with WGS-84 coordinate system.

• CSV (navigation data: projection centers in working c.s., heading/pitch/roll
angles and time) – file containing navigation data (coordinates of projection
centers in project coordinate system, angles in degrees, radians or gons) and
precise time from GPS-receiver.

6. The Line template field displays the list of fields, contained in each line of imported
file:

• T – precise time from GPS-receiver;

• Lat – flight latitude;

• Lon – flight longitude;

• Alt – flight altitude;

• Heading – flight heading;

• Roll – roll;

• Pitch – pitch.

The * symbols marks columns with data which is not imported.

In order to setup active template, perform one of the following actions:

• drag by mouse field name from the Available fields list to the column of the
Preview file table. After that the template in the Line template field is changes.
In order to cancel field selection, double click the column of the Preview file
table;

• change the template manually in the Line template field. At that column types
in the Preview file table are changed automatically.
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The button allows to use the default template T Lat Lon Alt Heading Roll
Pitch.

The button is used to compare the Line template field with data shown in the
Preview file table.

The active template corresponds only to lines shown in the Preview file table.

The button is used to replace specified field names by field values taken from
the first line of the Line template table.

7. [optional] The Automatically validate template checkbox is set on by default that
allows to select current template automatically. In order to configure the template
for file containing lines with different columns number, set off the Automatically
validate template checkbox and configure the template in the Line template field
manually.

8. [optional] To specify a line from to start data import, define the value of the Start
import from line parameter.

9. [optional] To display necessary number of lines in the Preview file table, set the
Preview maximum parameter. Default number of lines is 10.

10. In the Available fields section select necessary field name and drag it to the table
column. To cancel the field name double click the column header.

11. In the Field separators section set on one or multiple checkboxes to specify possible
fields delimiter symbol: Comma, Space, Tab, Semicolon or Other delimiters. De-
fault settings are comma and space.

12. In the Decimal separator section setup the following parameters:

• Point only – to use point only as a decimal separator in coordinates;

• Point or comma – to use both point and comma as a decimal separator in co-
ordinates.

If comma is used as Field separator, it is not recommended to use comma as Decimal
separator, since it may cause import of incorrect data.

13. [optional] In the Misc section set the checkbox:

• UTF-8 – is used to recognize text in Unicode encoding;

Unicode – symbols encoding format that allows to provide symbols of almost all written
languages.
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• Parse ° ’ “ – is used to recognize records of projection centers or GCP.

When using this parameter it is highly recommended to check points coordinates recognition
correctness after import. To do this select any point in 2D-window and check coordinates
values in the Marker window (see the Vectorization User Manual).

14. Click the Next button. The Exterior orientation import – Step 2 of 3: Import
settings window opens.

Fig. 16. Import options of exterior orientation parameters

Define the following parameters of datum:

1. In theAngles section specify measurement units for angles coordinates accord-
ing to data of the file to be imported:

• radians;
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• degrees;

• gons – plane angle measurement unit that equals to 1/100 of flat right angle
measurement unit, and full angle is 400 gons.

2. [optional] In order to make correction to kappa angle, set on the Add to the
kappa angle checkbox and input correction value to the input field.

3. [optional] In order to Invert sign for angles Omega, Phi and/or Kappa, set on
corresponding checkboxes.

4. [optional] Relief elevation is automatically set equal to values specified in the
project settings (see the “Project creation” User Manual). To change values of
relief elevation input then in min and max fields (in meters).

If the max value bigger than projection centers coordinates elevations, the error
message displays.

5. [optional] In the Precision (std. dev.) section change precision of a priori RMS
of measurements of projection centers coordinates and exterior orientation
angles.

6. [optional] In order to cancel automatic setting of the same precision by all axes,
set off the Uniform precision by all axes checkbox.

15. If import of exterior orientation parameters is performed using the Exterior orient-
ation parameters window, then click the Execute button. After that the exterior
orientation parameters are imported to the list of exterior orientation parameters.

If import of exterior orientation parameters is performed using the Orientation ›
Exterior orientation import... menu item or the button, then click the Next
button. The Exterior orientation import – Step 3 of 3: Additional actionswindow
opens.

Fig. 17. Additional actions after exterior orientation import
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Select and set the following checkboxes to perform automatic execution of these
actions just after import of exterior orientation parameters from file:

• Split block into strips by EO data – to split block images into strips using im-
ported exterior orientation parameters (if all images were loaded to a single strip
on a step of project creation);

• Create block layout by EO data – to create block layout considering imported
exterior orientation parameters;

• Adjust block based on imported EO data – to perform block adjustment using
imported exterior orientation parameters;

• Rotate images in block scheme by block layout – to re-create a block scheme
in 2D-window using block layout по накидному монтажу (this checkbox is
available if the Create block layout by EO data is set).

16. Click the Execute button. Exterior orientation parameters obtained after the import
are displayed in the table of the Exterior orientation parameters window.

17. Click the Apply button in the Exterior orientation parameters window to save
exterior orientation parameters folder in the project.

18. Click OK. The window closes block scheme by exterior orientation automatically
(to build initial block layout).

Fig. 18. List of exterior orientation parameters

The program provides possibility to create a block scheme by UAS images if angular
exterior orientation parameters of block images are specified with low accuracy or are
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unavailable. For this operation it is necessary to use the button of the Exterior ori-
entation parameterswindow toolbox. For each highlighted image the program calculates
the direction from previous to next center in a strip (for utmost images of a strip – from
adjacent image to the current one) and kappa angle is setup from this direction.

If the survey time is available the correct images order is checked, otherwise images in strips
should be located in chronological order only.

In order to eliminate blunders in block scheme building by exterior orientation parameters,
perform the following actions:

1. Refine block layout parameters, by performing the following actions:

1. Choose Block › Block layout. The Block layout window opens.

2. Choose the By ext. or. mode and click the Apply button.

See a description of block layout creation in the “Aerial triangulation” User Manual.

2. Import exterior orientation parameters from a file of text format once more and refine
import parameters.

3. To split images into strips by imported exterior orientation parameters (if any), per-
form the following:

1. Choose Block › Split into strips › By exterior orientation data. The Split
into strips by exterior orientation window opens.

Fig. 19. Split images into strips by exterior orientation

2. Specify the following parameters of splitting images into strips:

• Images order from by GPS-time or image names;

If the GPS-time is unavailable for part of images, they add to the separate strip
automatically;
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• Direction of motion between strips – up to down or bottom up;

• Direction of motion inside strips – left to right or right to left.

3. Click OK. Block scheme rebuilds by set parameters.

Block scheme, created using exterior orientation is an initial block layout and requires
further refining by tie/GC points (see Section 14.1).

14. Relative orientation
Refer to the “Relative orientation of images” chapter of “Aerial triangulation” User Manual for
the detailed description of relative orientation of images.

14.1. Automatic measurement of tie points coordinates

14.1.1. Workflow conditions and modes

The system provides possibility to measure tie points coordinates and perform relative
orientation in automatic mode. When working in automatic mode correlation algorithm
is used for search and measurement of tie points coordinates.

Data required for automatic tie points measurement

To perform automatic measurement of tie point coordinates the following data should
be available:

• interior orientation parameters of images, which will be considered in automatic
measurement of points coordinates;

It is highly recommended to perform interior orientation prior to automatic search of tie points,
since otherwise most of the filtering parameters are ignored, that considerably reduces relative
orientation quality.

• block layout (see the “Aerial triangulation” User Manual)

Sufficient condition for launch the operation of automatic measurement of tie points coordinates
is availability of initial (“rough”) block layout, considering, for example, size of images overlap
and/or quick ties data. However, the more data is used for the block layout creation, the more
accurate is the block scheme and, hence, the better the results of measurement of tie points
coordinates in automatic mode.

Modes of automatic measurement of tie points coordinates

TheAutomatic tie pointsmeasurementwindow have different configurations, provided
to process various data types:
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When working with airborne data the window allows to select manually optimal combin-
ation of basic and additional parameters of automatic ties search, measurement and
filtering, and also to save sets of this parameters as files with *.x-ini extension for the
further usage.

When working with UAS data the window allows to load parameters sets for automatic
ties search, measurement and filtering (so called “presets”).

Preset – parameters set of automatic tie points measurement, preliminary created by user or
setup in advance.

Order of automatic tie points measurement

To measure tie points using automatic mode (на примере airborne data) perform the
following:

1. Create a block layout considering available data.

Parameters of inter-strip stereopairs forming have a significant impact on automatic tie
points measurement and on further adjustment.

You can configure parameters of inter-strip stereopairs forming in the Parameters window
(Service › Settings) on the Block scheme tab, Forming interstrip stereopairs section.

Fig. 20. The “Forming interstrip stereopairs” section of the “Block scheme” tab of the
“Settings” window

• When specifying the Minimal images overlap for forming interstrip stereopairs
parameter, the user should correctly estimate the interstrip overlap value (in case of
“bad” overlap high values of this parameter will lead to the fact that interstrip ties will not
be measured);

• The Form stereopairs parameters allows to choose, which stereopairs with specified
overlap will be formed – all or with maximum overlap. If the all option is selected, it
allows to considerably increase the number of measured interstrip points, with significantly
increased time costs.

2. Setup parameters of tie points automatic measurement, transfer, filtering and start
the operation of automatic measurement of tie points coordinates.

3. Perform accuracy estimation of relative orientation and detecting of tie points
measurement errors.
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4. Manually eliminate errors of tie points measurement in the Points measurement
module or choose other filtering parameters (for example, specify more “strict” tol-
erances for measurement errors) and start the operation of automatic measurement
of tie points coordinates once more.

5. Update block layout considering tie points. Change settings of automatic tie point
measurement parameters if necessary and start once more operation of further
collecting of tie points measurements. Repeat steps 3-4 until obtain satisfactory
results.

14.1.2. Automatic tie points measurement on aerial survey data

Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation › Automatic tie point measurement › Aerial survey.
Automatic tie points measurement window opens.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.

2. Use default setting of measurement parameters or set manually themain parameters
for tie points search, measure and filter.

3. [optional] For more detailed tuning and refining of themainmeasurement parameters
set the additional parameters.

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Click the Distributed processing... button. The Distributed measurement
of tie points window opens.

The Maximum number of tasks for this project value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.
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Fig. 21. Parameters of distributed measurement of tie points in automatic mode

2. Specify the Number of tasks to create, which will be processed on one com-
puter. See the description of distributed processing setup in the General inform-
ation User Manual.

3. Click OK to go back to previous window.

5. Click the Start button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.

Main parameters of tie points measurement

The Automatic tie points measurement window allows to use presets of tie points
measurements, or manually choose optimal combination of basic and additional para-
meters for automatic search, measurement and filtering of tie points.

Choose Orientation › Automatic tie point measurement › Aerial survey. The Auto-
matic tie points measurement window opens.
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Fig. 22. The “Automatic tie points measurement” window

The Automatic tie points measurement window includes the following interface ele-
ments:

• the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

• a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;
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• the Tasks section used to specify main actions (measurement, transfer, filtering, re-
porting) during operation of automatic measuring of tie points coordinates;

• the Parameters section used to specify main parameters of automatic measuring of
tie points coordinates;

• the More button used to setup additional parameters of measuring of tie points co-
ordinates;

• the Start button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

• – allows to select triplets without tie points for repeated measures (these points
are marked as “not performed”), and their adjacent images (it allows optimize the
measurement time points);

• – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

• – allows to open the Block layout window to create a block layout or update it;

• – allows to open the Relative orientation report settings window used to specify
parameters and view a relative orientation report;

• – allows to open the Triangulation points window used to view a list of triangula-
tion points;

• – allows to open the Points measurement module and open automatically open
images selected in the list, if more than 6 images are chosen. Otherwise, an in-strip
stereopair with image selected in the list will be opened.

To save and load sets of main and auxiliary parameters the system provides the following
buttons:

• – is used to load a set of parameters from *.x-ini file saved previously in active
profile resources or out of them.

The arrow located next to the button allows to open a drop-down menu containing
the following items:

○ Load settings from file allows to open the Load settings window used to load a
set of parameters from *.x-ini file, located out of active profile resources;
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○ Reset settings to defaults allows to use default settings;

• – used to save setting of main and additional parameters to a file with *.x-ini
extension in active profile resources.

To save setting to a file with *.x-ini extension located out of active profile resources, open
drop-down list by clicking the arrow next to the button and choose Save settings to file....

Setting saving is used to create files with settings directed to work with certain type of block,
kind of images, or terrain, etc.

The Tasks section is used to specify the following actions during automatic tie points
measurement:

• Measure tie points in stereopairs allows to perform search and measurement of
tie points coordinates on in-strip and inter-strip stereopairs;

A stereopair is called in-strip, if it is formed by two adjacent images in a strip, and inter-strip
is any other stereopair of a block.

• Transfer tie points allows to perform transfer of measured points to adjacent stereo-
pairs (transfer of points located in triple overlap area to adjacent models), and transfer
of tie points to adjacent strips;

• Filter tie points by relative orientation allows to perform points filtering that have
measurements, exceeding specified values of errors thresholds;

Points check if to filter them or not, is performed sequentially by errors type – first check -
whether the point falls within specified correlation threshold, then whether it does not exceed
maximal vertical parallax value, and finally, search for triplet errors is performed, if the appro-
priate option is specified.

Check for exceeding correlation threshold is applied only to new points (if measured points
are already available). In order to check all points whether they exceed correlation threshold,
set the additionalDelete points with correlation below threshold checkbox on theRejection
tab in the Tie point measurement parameters window of additional parameters.

It is possible to perform actions with tie points inside strips, between strips, or not perform at
all.

• Filter tie points by adjustment results allows to perform automatic block adjustment
using specified parameters and to filter measured tie points after that;

Points filtering using adjustment results is applied if there are blunders on images between
strips. The filtering is performed using residuals tolerance specified in the Adjustment
parameters window, see the “Block adjustment” User Manual.
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• Report on relative orientation on completion allows to open the Relative orient-
ation report window automatically to view and edit tie points measurements just
after completing of automatic relative orientation.

TheParameters section allows tomake the following settings of automatic measurement
of tie points coordinates:

• Points per stereopair – allows to specify a number of points to be measured on in-
strip and inter-strip stereopairs;

Resulting amount of measured points may be either greater than a predetermined amount –
because of points transfer from adjacent stereopairs, or less due to further filtering. Default
amount of points is 30 per each images pair in forward overlap and 10 points in side overlap.
The minimum number of points to perform control by the vertical parallax residual – 6 points.

The Points per stereopair parameter depends on settings defined on the Miscellaneous
tab in the Tie point measurement parameters window.

• Correlation threshold (%) – minimal acceptable value of correlation coefficient for
tie points, that will be selected during automatic search;

Recommended values lie in range from 90 to 95%. In contrast to all other filtering criteria,
this parameter directly influences on operation of points measurement and transfer. Check
for exceeding of correlation threshold is performed only for new points (if there are already
measured points). To check all measured points for exceeding of correlation threshold (usually,
at final stage of collecting measurements of tie points) set the additional Delete points with
correlation below threshold checkbox on the Rejection tab in the additional parameters
window.

• Maximum vertical parallax (in pixels or mm) – threshold value for rejection executed
after points measuring/transfer. On each step of rejection process, the program
searches for the point with maximal Y-parallax on the stereopair and rejects it. After
that, it makes relative orientation once more and the iteration is executed until max-
imal Y-parallax exceeds the parameter specified here, or until 6 points or less remain
on stereopair. Recommended value is a pixel size;

• Maximumerror in triplets in XY-plane and by Z (in pixels, meters or mm) – threshold
discrepancy of points measurements on adjacent stereopairs in triple overlapping
zone of adjacent images in a strip. Use the following formula to calculate values of
acceptable errors in triplets:

Emax ≈ 2 Emean , where Emean – acceptable mean error.

Mean triplet errors in XY plane is calculated using the following formula:

RMS ≈ 2 Emean
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Mean error by Z equals the mean error value in XY plane multiplied by the ratio of
focal length (f) to survey basis (b):

Emean
z = f

b Emean
xy .

• Measure points by zones – allows to apply a method of sequential measurement
by zones of overlap area. If the checkbox is cleared, points search is performed over
the whole area of images overlap. The system allows to select zones and define their
size in the Zones section on the Miscellaneous tab of the additional parameters
window;

• Filter points by zones – is used to filter points in stereopair zones sequentially;

The operation provides filtering the worst (by parallax) points on stereopair, passing zone by
zone one after another. So the worst point on stereopair is found and deleted first, then the
worst one in the next zone and so on. Uniformity of point’s distribution on stereopair is also
verified in such a way.

• DEM – allows to choose a DEM (if any) to consider its data during automatic tie points
measurement. For this it is necessary to have saved adjustment results available.

This parameter allows to use DEM for calculation of the true position of the point. Thereby
the required search area of points reduces.

Click the button to clear a DEM.

Additional parameters of automatic measurement of tie points coordinates

For more detailed setup and adjustment and refinement of the basic parameters of tie
points coordinates measurement the Tie point measurement parameters window of
additional parameters is used. It is opened using the More button located in the main
Automatic tie point measurement window.
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Fig. 23. Points search parameters

The Tie point measurement parameters window contains four tabs with parameters.

To reset to default parameters, delete the ProjCorrMatchOptions.x-ini file located in the project
root folder.

The Search for points tab allows to setup the following parameters:

• Search area (pix) – allows to specify a “halfsize” of area of matching point search;

• Contrast point search area (pix) allows to search tie points in areas with maximal
contrast (on images with clear objects outlines);

In some cases it is reasonable to measure points in areas with low contrast, for example,
when forested areas have maximal contrast, and in these areas correlator’s errors are very
probable. In this case the Contrast point search area value should be set to 0.

• Tries per point – number of tries of matching point search with correlation coefficient
value that exceeds specified in the search area;

• Multipass points search allows to perform points search and filtering on stereopairs
in multiple passes with help of different algorithms. It is applied in case of insufficient
quality of the block layout, when real relative rotation of images relative to each other
is sufficiently big;

For multipass points search it is recommended to set correlation threshold high enough, for
example, 95%.

It is recommended to use multipass points search for UAS images.

55

Processing of UAS dataPHOTOMOD 6.4



• Search the whole images area allows to specify images pairs to search points: ad-
jacent images in each strip and/or non-adjacent pairs of images in a strip and inter-
strip pairs of images.

Fig. 24. Parameters of correlator

The Correlator tab is used to setup parameters of area correlator work and contains
the following parameters:

• Correlation matrix half size (pix) allows to specify size of correlation matrix by X
and Y axes;

• Autocorrelation control allows to specify level of auto-correlation – the Maximum
value of sigma in Gaussoid that is the top limit of distribution of the mask correlation
coefficient in a small area on the same image. The more the sigma value, the less
probability of correct points measurement, which were measured using correlation
with the given point as an initial one;

• Do not use image border area is used to specify a size of area near the image
border, that is not used during correlation operation;

Service area width (2% of image width and height by default) should not be less than on the
image; otherwise a big amount of “bad” points would be measured in image service areas.

• the Image blur slider is used to consider image material quality, from No to Strong
blur.

For images without blur or with negligible blur it is highly not recommended to place the slider
to position different from No.
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In most cases the Image blur parameter is applied for processing of UAS images block.

Fig. 25. Filtering parameters

The Rejection tab is used to setup filtering parameters of points found and contains
the following options:

• Preliminary filtering with detection of trusted points group is used to preliminary
filtering of blunders, that do not allow calculate correctly angular elements of relative
orientation (see the parameters of trusted points group on the Miscellaneous tab);

• Delete all tie points, if after filtering number of them left is less then specified
number – allows to delete all tie points on a stereopair, acquired during operation of
automatic measurement of points coordinates, if after their filtering their number is
not sufficient to perform correct relative orientation;

• Deletemeasurements on non-adjacent images allows to filter potentially erroneous
points, measured on non-adjacent images inside a strip;

To measure tie points for UAS images in two steps it is recommended to set the Delete
measurements on non-adjacent images checkbox on the first step and to not to use this
parameter on the second step.

• Delete single points allows to reject points measured on single images;

• Delete points with correlation below threshold allows to delete points previously
measured using correlator, if their correlation coefficient in below threshold value
specified in theCorrelation threshold field of theAutomatic tie point measurement
window;
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It is recommended to use the option for recurrent or final points filtration, since the filtering
covers all measured points, not only new ones, added during just another start of automatic
tie points measurement operation.

• Delete points surplus allows to delete points, if their number exceeds number spe-
cified in the Points per stereopair field of the Automatic tie point measurement
window, sorted by the Y-parallax in descending order;

The parameter considers whether the Filter points by zones checkbox is marked, that allows
to delete points evenly. It is recommended to use the option after the initial tie points meas-
urement on UAS images.

The points are deleted regardless of type and number of measurements per point (the system
may delete both GC point and the points in triple overlap).

• Check correlation of measurements transferred from other stereopairs is used
to check on each stereopair correlation coefficient of measurements, collected during
points transfer from other stereopairs, since the chain of such transfers may lead to
errors accumulation and bring unacceptable result;

• X-parallax clipping (%) allows to specify number of points with minimal and maximal
x-parallax (relatively to total amount of points) which will be deleted after filtering in
strip and between strips.

It is recommended to apply this rejection method if erroneous points are dispersed clearly
along stereopair basis (if, for example, a highway with bright marking goes in parallel to survey
basis and correlator puts points on marking line elements, which do not correspond with each
other.

• Check by reverse stereopair –allows to check the search results on reverse stereo-
pair; if the results are not equal, point deletes;
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Fig. 26. Miscellaneous parameters

TheMiscellaneous tab contains sections and options to setup the following additional
parameters:

• Number automatically measured points starting with is used for automatic num-
bering of measured tie points starting with number, specified in the entry field, that
allows to distinguish these points from the ones already measured on the project
images;

Regardless of the set value, the system does not generate points with duplicate numbers. If
the point with some number already exists, then this number will be skipped when creating
new points.

• Minimum distance between points (pix) allows to specify minimal distance in pixels
between points measured on the image;

It is recommended to increase the value of this parameter, when the problems with block
adjustment occur. The parameter is considered only during measurement new points. Existing
tie points are not rejected.

• Minimal dispersion allows to specify minimal dispersion of mask to protect from
points search on the clouds and water bodies;

The option is used to exclude points in monotonous areas, for example, for satellite scanner
images, if there are black strips on images borders, and for overexposure due to cloudiness.
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• Pyramid level for preliminary search (only for central projection images) – allows
to choose an image pyramid level used to preliminary search of points. If the checkbox
is set on, preliminary search is performed by source image;

• Fixed search sequence – allows to obtain the same results of automatic measure-
ment of tie points coordinates during multiple runs of the operation with the same
initial parameters;

• Use automatic block layout results allows to use the block layout results, automat-
ically created for UAS images;

If the automatically generated block layout is available, then during automatic measurement
of tie points coordinates information from current block scheme is not used, and the Search
the whole images area parameter is also ignored. The default search parameters are used
only (considering data of automatic block layout).

• The “Points per stereopair” parameter influences on the Points per stereopair
parameters located in the Automatic tie point measurement window and allows to
select the following number of points:

○ Points to add per session – values specified in the main window, that mean a
number of new points, which will be added to already measured ones;

○ Target number of points on a stereopair – values specified in the main window,
that define total points number;

The resulting number of measured points may be both greater than a predetermined amount –
due to points transfer from adjacent stereopairs, and less due to the subsequent rejection of
points. Default value is 30 points on each in-strip images pair, and 10 points – in inter-strip
overlap. The minimum number of points to control the vertical parallax residual is 6.

• parameters which allow to specify trusted points group to be used as a master sample
for points rejection (see the Preliminary filtering with detection of trusted points
group parameter on the Rejection tab). A group of points is considered as trusted
if the following two conditions are met during the points search:

1. The distance between the point on one image and the corresponding point on
another image should not exceed the parameter specified in the Maximum
spread radius within trusted points group input field.

2. Number of points found, which satisfy to the first condition should not be less
than the parameter specified in the Minimum trusted points group size input
field.

If a trusted group has been found, it supposedly means that angles of relative orient-
ation have been computed correctly and the points rejection can be performed using
these data. Otherwise, the rejection of points will not be executed, even if the Prelim-
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inary filtering with detection of trusted points group checkbox is set on the Re-
jection tab.

TheMaximumpoints to use filtering by trusted group parameter is used to specify
the limitation on the number of points to reject.

It is recommended to set theMaximum points to use filtering by trusted group value from
40 to 60. It is not recommended to set more than 60 points.

The Stereopairs section contains the following parameters:

• Create stereopairs based on exterior orientation data, from images, projection
centers of which are within range of – if this option is checked, the stereopairs will
be composed from images, projection centers of which are located at the distance
no more than a specified value (in meters), otherwise, the stereopairs are composed
from nearest images in a strip.

• From different strips only – if this option is checked, the in-strip stereopairs will not
be considered. Otherwise, all in-strip stereopairs will be considered, including the
nonadjacent.

Fig. 27. Miscellaneous parameters

The Zones section allows to define a zone size on a stereopair, where the system
performs automatic search and measurement of tie points coordinates. Refer to the
“Aerial triangulation” User Manual for information about recommended zones.
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The Points transfer section contains the following parameters:

• Strict limits for initial point position – if the checkbox is set, the system performs
search for a point only inside of image, otherwise, the search is possible out of the
image boundary, if the Search area parameter value on the Search for points tab
exceeds the image size.

• Automatically transfer manually measured – allows to transfer tie and/or GCP,
measured manually.

• Automatically reject manually measured – if the checkbox set on, tie and/or GC
points manually measured are not transferred.

• Points, measured automatically – allows to transfer and filterGC points, measured
automatically.

If checkboxes for filter are set on, but checkboxes for transfer are set off, filter does not per-
form, because there is no transfered points.

The Rejection by angles section allows to specify parameters of measured points fil-
tering by single or multiple relative orientation parameters of the right or left image.

In some cases after automatic measurement of tie points coordinates due to erroneous
points the images are rotated in a block and their relative orientation parameters are
calculated incorrectly. To prevent images rotation the filtering of measured tie points
by the values of the rotation angle is used. To do this it is necessary to change angles
threshold value (in degrees) for each of stereopair elements. As a result, the points
which cause exceeding of angles thresholds will be rejected after relative orientation
recalculation.

It is not recommended to use this method of rejection for blocks, in which the images can actually
be rotated in relation to each other, since in this case the likelihood of removing properly placed
tie points increases.

14.1.3. Automatic tie points measurement on UAS data

Automatic measurement of tie points coordinates

To measure tie points coordinates in automatic mode perform the following actions:

1. Choose Orientation › Automatic tie point measurement › UAS. The Automatic
tie points measurement window opens.

For automatic measurements all images are selected by default. For tie points search just
on selected images clear the checkbox Select all images for automatic tie point meas-
urement on the Orientation tab of the Parameters window.
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2. Use default settings of measurement parameters (presets) or set manually the main
parameters for tie points search, measure and filter.

3. [optional] Specify the adjustment parameters, if it is necessary to perform the ad-
justment on the current project step, otherwise – clear theMake block adjustment
checkbox..

4. [optional] In order to use distributed processing during measurement of tie points
coordinates, perform the following actions:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing... button. The Distributed processing set-
tings window opens.

Specify the Maximum number of parallel tasks value is displayed in the
window. This parameter shows howmany processing tasks is possible to divide
the current project to.

In case the workstation processor supports the hyperthreading technology, it is recom-
mended to reduce themaximum number of parallel tasks by half in order to ensure
system’s stability.

Hyper-threading (hyper-threading technology) is simultaneous multithreading imple-
mentation used to improve parallelization of computations. With HTT, one physical
core appears as two processors to the operating system, allowing concurrent
scheduling of two processes per core.

Fig. 28. Parameters of distributed measurement of tie points in automatic mode

3. Click OK to go back to previous window.

5. Click the OK button in the Automatic tie points measurement window to start
operation of automatic measurement of points coordinates.

6. Open the relative orientation report to view results of relative orientation operation
and to fix measurement errors.
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Main parameters of automatic tie points measurement

The Automatic tie point measurement window allows to use parameters presets of
tie points measurement, or to manually choose the optimal combination of basic and
additional parameters for automatic tie points search, measurement and filtering.

Choose Orientation › Automatic tie point measurement › UAS. The Automatic tie
points measurement window opens.

Fig. 29. The “Automatic tie points measurement” window

The Automatic tie points measurement window includes the following interface ele-
ments:

• the images selection toolbar used to open auxiliary windows, to save and load sets
of parameters;

• a list of project images allows to select images, scheduled to perform automatic
measuring of tie points coordinates;

• the Correlator configuration section is used to load, create and edit sets of para-
meters of automatic tie points measurement;
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• the Parameters button is used to setup block adjustment parameters;

During adjustment, at the stage of automatic tie point measurement, default adjustment
parameters are to be changed:

○ Point on image measurement precision (RMS) (formanual measurements and auto-
matic measurements, see the “Bundle adjustment method” chapter in the “Block adjust-
ment” User Manual) is equal to the Maximum vertical parallax (in pixels) value set in the
preset determining automatic tie point measurement parameters (see below).

Values of Maximum vertical parallax (in pixels) for various presets:

■ Low correlator accuracy – 4;

■ Medium correlator accuracy – 2.50;

■ High correlator accuracy – 1.50;

■ User preset – set by user.

○ The Perform direct georeferencing checkbox is cleared (see the “Method of initial ap-
proximation by a block scheme” section in the “Block adjustment” User Manual);

• the OK button used to launch an operation of tie points measurement and to perform
relative orientation in automatic mode;

• the Distributed processing button is used for automatic tie points measurement in
distributed processing mode.

The system provides the following buttons in the toolbar to work with auxiliary windows:

• – allows to select stereopairs where there is no tie points coordinates measure-
ments, and their adjacent images;

• – allows to select triplets without tie points for repeated measures (these points
are marked as “not performed”), and their adjacent images (it allows optimize the
measurement time points);

• – allows to select interstrip stereopairs where there is no tie points coordinates
measurements, and their adjacent images;

To configure automatic tie points measurement and (optionally) for further adjustment
procedure the following parameters are used:

• [optional] clear the Calibrate camera checkbox if camera calibration has already
done and is not needed;

It is recommended to clear the Calibrate camera checkbox only if there is reason to trust
the camera calibration (see the chapter “Interior orientation” chapter of the current User
Manual). It is necessary to consider, that if the calibration was not carried out in actual oper-
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ating conditions, then significant discrepancies in the obtained calibration parameters may
occur.

If polyplets (sets of several overlapped images located on different strips) are not found, one
of camera calibration stages (calibration by polyplets) will be skipped (an appropriate warning
message will appear). Other calibration stages will be carried out.

• [optional] clear the Make block adjustment checkbox if the adjustment operation is
not necessary at this stage of the project;

The adjustment parameters are described in the “Block adjustment” chapter of the current
User Manual.

• [optional] clear the Assign self-calibrated camera checkbox if needed (see the
“Using self-calibration” chapter of current User Manual);

• [optional] clear the Delete intermediate data checkbox to not to delete processing
data after computation is complete. It is recommended to leave the checkbox set if
automatic re-measurement of tie points coordinates is not planned;

The intermediate processing data may occupy a significant.

Sufficient condition for launch the operation of automatic measurement of tie points
coordinates is availability of initial (“rough”) block layout. In this case it is not recommen-
ded to clear the Low block layout quality checkbox.

TheCorrelator configuration section is used to load, create and edit sets of parameters
of automatic tie points measurement;

• the download button in the right part of the Correlator configuration section allows
to open the Correlator precision window, which contains a list of available (both
predefined and user-created) presets and the following buttons:
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Fig. 30. The “Correlator precision” window

○ Create – allows to create a custom preset – set of parameters of automatic tie
points measurement. Click the Create button to open the Enter entry window,
where user should enter a name for a preset to be created (default user preset).

Fig. 31. The “Enter entry” window

It is not allowed to create presets with identical names. When you try to create presets
with identical names, the system opens a window with a corresponding error message.

Clicking the OK button opens the Edit parameters window, where you should
manually specify the following parameters:
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Fig. 32. The “Edit parameters” window

■ Starting pyramid level – it is recommended to increase the value of starting
pyramid level when system performance is insufficient, and when there is no
high requirements to processing results accuracy. Recommended value of
starting pyramid level is 1. The value of the starting pyramid level that equals to
zero provides maximum accuracy of the results, but leads to increasing of data
processing time;

■ Ending pyramid level – it is recommended to increase the value of ending
pyramid level when using data with different resolution (including cases of signi-
ficant difference in spatial resolution within one image);

For example, when using data which resolution varies 2 times, it is recommended to
increase the default value of the ending level of the pyramid on the one.

■ Maximum vertical parallax (in pixels or mm) – threshold value for rejection
executed after points measuring/transfer. On each step of rejection process, the
program searches for the point with maximal Y-parallax on the stereopair and
rejects it. After that, it makes relative orientation once more and the iteration is
executed until maximal Y-parallax exceeds the parameter specified here, or until
6 points or less remain on stereopair. Recommended value is a pixel size;

■ Points per stereopair – allows to specify a number of points to be measured
on in-strip and inter-strip stereopairs;

The resulting number of measured points may be both greater than a predetermined
amount – due to points transfer from adjacent stereopairs, and less due to the sub-
sequent rejection of points. Default value is 30 points on each in-strip images pair, and
10 points – in inter-strip overlap. The minimum number of points to control the vertical
parallax residual is 6.
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■ Set the Filter non-transferred points checkbox on to reject points located on
inter-strip stereopairs. A point will be filtered, if the system recognizes it on a
single image of some strip.

When you click OK, the system creates a new user preset – a set of parameters
used for automatic tie points measurement.

○ the Edit button allows to open the Edit parameters window to change settings of
the selected preset.

○ the Copy button allows to copy a preset.

○ the Rename button allows to rename a preset.

○ the Delete button allows to delete a preset.

○ the Close button allows to close the Correlator precision window.

• The arrow to the right of the button which opens the Correlator precision window
allows to open a drop-down list, used to select one of the following presets.

Fig. 33. Presets drop-down list

• The system provides a set of predefined presets, allowing to vary the accuracy settings
of automatic tie point measurements. Predefined presets are marked by the asterisk
symbol “*” – Low, Medium and High correlator accuracy.

Fig. 34. Presets drop-down list

The system does not allow the user to edit the predefined presets. A copy of the predefined
preset is available for editing, as well as a custom preset.
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15. Ground control points
Refer to the “Aerial triangulation” User Manual for the detailed description of the Points meas-
urement module and Triangulation points window.

15.1. Import of GCP catalogue

The system provides import of GC points coordinates list from file with *.csv or *.txt
extension.

Refer to the “Import of triangulation points from X-points” chapter for the description of the GC
points import from file with *.x-points extension.

To perform import of GC points coordinates list from file perform the following actions:

1. Click the Import catalog button on the Aerial Triangulation tab of the main
toolbar.

2. Select a file containing GCP catalogue and click OK. The Import GCP catalogue
window opens.
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Fig. 35. Import of GCP catalogue

3. The Line template field displays a list of fields, contained in each line of the import
file:

• Name – object’s name;
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If imported file does not contain a column with GCP names (numbers), then after import
operation the names like Point0001 are assigned to the points automatically.

• X Y Z – values of GC point coordinates by X, Y, Z;

• STDDEVX, STDDEVY, STDDEVZ – accuracy of coordinates measurements by X, Y, Z
axes (RMS);

• * – missed field during import.

All objects are saved using the same template. Each line of a file contains the same
number of fields, that equals to number of fields in template. Lines which does not
correspond to the template, are skipped. To all vertexes two (for 2D objects import)
or three coordinates are specified.

In order to setup active template, perform one of the following actions:

• drag a field name from the Available fields list to the Preview file table column.
After that the template in the Line template field is changed. To cancel a field
selection, double click the Preview file table column;

• change a template manually in the Line template field. After that column types
in the Preview file table will be changed automatically.

The button is used to return to default template Name X Y Z.

The button is used to compare the Line template field with data shown in the
Preview file table.

Active template corresponds only lines shown in the Preview file table.

The button is used to replace specified fields names with fields names from the
first line of the Preview file table. It is possible to specify any names for vectors
import.

For import of laser scanning data the field names from the list of available names are
specified.
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Fig. 36. Setup of a template sample

4. [optional] For automatic selection of current template the Automatically validate
template checkbox is set by default. In order to setup a template for a file that
contains lines with different number of columns, clear the Automatically validate
template checkbox and setup the template manually in the Line template field.

5. [optional] In order to define a line from which to start data import, input the line
number to the Start import from line field.

6. [optional] In order to display necessary number of lines in the Preview file table,
set the Preview maximum parameter. 10 lines are displayed by default.

7. In the Available fields section select desired field name and drag it on a table
column. To cancel the selection of the field name double click the column header.

8. In the Field separators section set single or multiple checkboxes to specify field
separators in the file: comma, space, tab, semicolon or other. The comma and
space are set by default.

9. In the Decimal separator section set the following parameters:

73

Processing of UAS dataPHOTOMOD 6.4



• Point only – to use only a point as a decimal separator in coordinates;

• Point or comma – to use both a point and a comma as a decimal separator in
coordinates.

If the Field separator is selected as a comma, it is not recommended to specify the
Decimal separator as a comma, since objects with incorrect coordinates will be created
after import operation.

10. In the Misc section set the following checkboxes:

• UTF-8 – is used to recognize text in Unicode coding;

• Parse degrees minutes seconds – is used to recognize records from the list
of projection centers or GCP.

When using this parameter it is highly recommended to check recognizing correctness
after import operation.

11. The Preview file table contains data of imported file. Fields type according to the
template, located in the Line template field, are automatically assigned to the table
columns.

The * symbols marks columns with data which is not imported.

12. In the Points with existing names section specify actions to perform when names
of imported GC points coincide with points names already existing on the GCP list
tab:

• Replace – allows to replace a point with the same name in the list, i.e. the point
data will be updated;

• Skip – allows to cancel import of GCP with the same name.

13. [optional] To prevent creating text attributes without value during import, set the Do
not create empty text attributes checkbox on.

When the Do not create empty text attributes checkbox is on, in some cases a data loss
may occur.

14. [optional] To convert coordinate system set the Convert coordinate system
checkbox and specify source and output coordinate systems.

15. Click OK. The Import ground control points window opens, which contains the
GCP table to be added. Points which names are the same as names of existing
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GCP in the GCP list of the Triangulation points window are shown by red color,
new GCP – by black color.

Fig. 37. Selecting GCP to be added to the list

16. Select points to be imported using checkboxes and/or standard selection tool. Click
OK. After that coordinates of GC points with set checkboxes will be loaded in the
end of the GCP list. The Points measurement module and Triangulation points
window (on GCP list tab) are opened (see the “Aerial triangulation” User Manual).

If in the Points with existing names section the Skip parameter is selected, then only
new GCP are selected for adding by default, if the Replace parameter is selected, all GCP
checkboxes are selected to be added.

If RMS of X, Y, Z coordinates was not imported or is absent in GCP file, then default value
of RMS for all coordinates is 0.2 meters.

16. Adjustment
Refer to the “Block adjustment” User Manual for the detailed description about block adjustment
procedure.

16.1. Preliminary block adjustment

In order to adjust images block perform the following actions:

1. Click the button of Block editor window’s toolbar to refresh initial block scheme
(to refine block layout) using measured tie and GC points.

See a description of block layout creation in the “Aerial triangulation” User Manual.
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2. Choose Orientation › Block adjustment or click the Block adjustment button
on theAerial Triangulation tab of the main toolbar. The adjustment toolbar opens.

See detailed description of interior orientation step in the “Aerial triangulation” User
Manual.

3. Click the button Settings on the Adjustment toolbar. The Settings window
opens.

Fig. 38. Adjustment parameters for the first adjustment operation

4. On the Adjustment tab define the following parameters for the first start of the ad-
justment procedure:

1. Choose the by block scheme option in the Approximation computing
method section.

2. Click the Initial approximation parameters button. The Initial approximation
parameters window opens.

3. Set theUse ground control points coordinates andUse projection centers
coordinates checkboxes.

4. Click OK.
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5. Choose the bundle adjustment option in the Adjustment method section.

6. Click theAdjustment parameters button. TheBundle adjustment parameters
window opens.

7. Set theUse ground control points coordinates andUse projection centers
coordinates checkboxes.

8. Choose the in 3D space option in the Minimize residuals section.

9. Click OK to return for the Parameters window.

5. Click Compute to start the adjustment operation.

6. To analyse the adjustment results you can use visual control of residuals on block
scheme and the Residuals window which contains brief residuals report.

7. Pick out adjustment parameters, analyse and eliminate residuals to obtain satisfying
adjustment result.

After making any alterations to points measurements data it is necessary to re-start the
adjustment procedure once again.

At subsequent start of the adjustment, the results of previous adjustment processes are
used by default (the Use current solution checkbox on the Adjustment tab of the Para-
meters window).

The system allows to perform re-adjustment by changing any settings of bundle adjustment
(in this case it is not recommended to clear the Use current solution checkbox, since that
can lead to poor adjustment results).

8. It is recommended to use self-calibration of camera parameters during adjustment
procedure, if camera without calibration was used.

16.2. Using self-calibration

[optional] If a complete set of camera parameters is unavailable, use self-calibration of
camera parameters during adjustment procedure.

Self-calibration of camera parameters – is automatic calculation of camera parameters (correc-
tions to principal point coordinates and focal length, distortion coefficients) during adjustment
operation.

In PHOTOMOD UAS system self-calibration of camera parameters option is set on by default.

To use self-calibration of camera parameters during adjustment operation perform the
following actions:
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1. Make sure that the Perform self-calibration checkbox on the Adjustment tab of
the Parameterswindow is set on and click the Self-calibration parameters button.
The Camera parameters self-calibration window opens.

See detailed description of self-calibration operation in the “Block adjustment” User
Manual.

2. Choose camera to be calibrated in the Cameras table.

3. Select the Calibration type: Physical or Mixed.

For self-calibration of a camera having a focal plane shutter, it is recommended to use
Mixed self-calibration.

4. In the Coefficients table define initial values of camera parameters in the Initial
value column and choose parameters for optimization in the Optimize column.
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Fig. 39. Self-calibration of camera parameters

5. Click OK. Setup adjustment parameters in the Parameters window and click the
Compute button to start the adjustment procedure.

6. When the adjustment procedure is completed estimate the adjustment accuracy
and results of camera self-calibration shown in the Adjustment column of the
Camera parameters self-calibration window. If you are satisfied with the results
pass to step # 5, otherwise, change initial values of parameters and/or set of para-
meters for optimization and adjust the block once more.

7. Click the Save button to save the adjustment results.

8. Choose Orientation › Manage cameras. The Manage project cameras window
opens.
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9. In the Project cameras list select new calibrated camera (cameras) [autocal].x-
cam and assign it (them) to project images. Click the Execute button. Click OK.

See a description of the Manage project cameras window in the “Aerial triangulation”
User Manual.

10. Choose Orientation › Additional › Calculate interior orientation.

11. Choose Orientation › Block adjustment or click the Block adjustment button
on the Aerial Triangulation tab of the main toolbar. Click the button Settings
on theAdjustment toolbar. Block will be adjusted considering new results of interior
orientation.

16.3. Brief residuals report

The program allows to display brief residuals report, which contains RMS errors, mean
absolute and maximal adjustment errors.

Brief residuals report is used for quick estimation of adjustment results without viewing
detailed report.

In order to display brief residuals report, click the button on the Adjustment toolbar.
The Residuals window opens.
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Fig. 40. The “Residuals” window

In the Stereopairs mode brief report contains information about mean absolute errors
on GCP and check points (in meters), about tie and targeted points, as well as about
tie residuals on projection centers (mutual and from mean residuals).

If adjustment is performed by bundle adjustment procedure, the Sigma_0 value is calculated.

The Sigma_0 value shows howmuch adjustment discrepancies correspond to specified thresholds
on points coordinates measurements and input GCP data (GCP and projection centers coordin-
ates). If the thresholds were specified correctly, the Sigma_0 has value close to 1 (±30%).

If the Sigma_0 is much greater than 1, there are errors in points coordinates measurements, in
input GCP data or because of incorrectly specified thresholds on points coordinates measure-
ments. If the Sigma_0 is mush less than 1, the threshold on points coordinates measurements
were specified incorrectly or there are some other errors (see Section 16.4).

16.4. Creating adjustment report

The program provides possibility to view full statistics of adjustment, summary information
about adjustment residuals and control data.
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To display adjustment report the button on the Adjustment toolbar.

Fig. 41. The window of adjustment report

The toolbox of the Report window contains the following buttons:

• – allows to edit a font of report text;

• – allows to edit (make changes) a report (F4);

• – allows to start search in report’s text (Ctrl+F, Ctrl+G and F3);

• – allows to save a report into text file;

The report also saves in the \backup project folder automatically with the adjustment results
(only for central projection images).

• – allows to save a report into program resources;

• – allows to print a report;

• – allows to setup report printing parameters.

The adjustment report displays the following values:

• residual values calculated on GCP, check, tie points, and projection centers for the
whole block and for each point;
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• catalogue of points coordinates;

• images exterior orientation parameters;

• GPS corrections;

• corrections for exterior orientation parameters.

Report content is setup on the Report tab of the Parameters window.

Residuals and errors are displayed in the report as follows:

• X, Y, Z – coordinates values taken from model (from strip when using independent
strips method, from stereopair when using independent stereopairs method);

• X1, X2, Y1, Y2, Z1, Z2 – values of points coordinates on two different models;

• Xср, Yср, Zср – values of points coordinates, averaged over all models;

• Xg, Yg, Zg – geodetic value of points coordinates, specified by the user for GCP and
check points;

• Exy, Ez – average residuals of points XY and Z coordinates;

• dX, dY, dZ, dS – discrepancies on GCP;

• dX, dY, dZ, dXY – GPS corrections on projection centers.

16.5. Adjustment accuracy control

It is recommended to perform control of block adjustment accuracy after the completion
of the adjustment operation. The adjustment results are displayed in graphic form as a
residuals vectors in the Stereopairs and Images modes of working windows, numeric
values of residuals are included to adjustment report.

If the adjustment brought unsatisfactory results and there some blunders the program
provides possibility to improve the results using editing of points position. To do this it
is necessary “re-measure” points, on which the residuals vectors exceed defined
threshold and are shown by red color.

The program provides two ways of points position editing:

• by change of points geodetic coordinates;

• by change of points position.

In order to change geodetic coordinates of points on image perform the following actions:
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1. Select a point on a block scheme or in a list, which error exceeds specified threshold
value.

2. Click the button. The Points attributes window opens.

3. [optional] In order to display the editor panel set the Editing panel checkbox in the
Information window.

4. Click the Coordinates button. The Point coordinates window opens. For GCP
and check points the X, Y, Z, all checkboxes are set, and coordinates and accuracy
values (standard deviation) of these coordinates in meters are displayed in corres-
ponding fields.

Fig. 42. Changing geodetic coordinates of selected GCP

5. [optional] To change the value of the Accuracy parameter use the or button.

6. To change a type of selected point set a type in the Point type section.

If the Tie type is specified for GCP or check point, its geodetic coordinates will be deleted.

7. Input necessary coordinates to the X, Y, Z input fields or clear one or multiple
checkboxes to use a point as a XY or Z.

When working with a scanner images it is possible to use only XYZ GCP, that is why if for
the GCP one of the X, Y, Z checkboxes is cleared, the point is used as a tie point and its
coordinates are not considered during adjustment. If such points are available in a project,
the program shows warning message during adjustment.

8. [optional] Click the Revert button to restore initial points coordinates.

9. Click OK. After that the geodetic coordinates of point will be changed.

In order to change point’s position on image perform the following actions:

84

Processing of UAS dataPHOTOMOD 6.4



1. Select a point on a block scheme or in a list, which error exceeds specified threshold
value.

2. Click the button. The Object attributes window opens.

3. Click the Measure button. The Points measurement window opens.

Fig. 43. Editing of selected point

4. Move a point manually or using correlator (see description of correlator work in the
“Aerial triangulation” User Manual).

5. Click OK. The Points measurement is closed as a result.

6. Click Compute to complete changing point’s position on image.

In order to use interstrip points and points non-transferred in some strip in the adjustment by
independent strips method or independent stereopairs method, it is necessary to measure co-
ordinates of the points on adjacent images inside the strip during aerial triangulation or in the
Points measurement window (see the “Aerial triangulation” User Manual).

17. Preparation steps for the DEM creation
Refer to the “DTM Generation” User Manual for the detailed information about generation of
digital elevation model (DEM).

17.1. Grid creation

The program provides possibility of regular grid creation with specified step. A grid step
is used as a frequency of nodes creation, in which vicinity spatial coordinates are cal-
culated and points are created.
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The grid could be created both for the whole images block and for any part of a block
or for selected stereopair. A shape of grid borders could be rectangular or as arbitrary
polygon.

To create a grid select Grid › Create (Ctrl+N, G). After that a new layer Grid is created
in the Manager.

Area of grid creation is determined in one of the following ways:

• in order to create a grid with specified rectangular border, press and hold the Shift
key, and drag by mouse a rectangular area over images block or over selected ste-
reopair;

• in order to create a grid with arbitrary border, define a grid creation area in group
selection mode by polygon and while holding pressed the Shift key, specify by mouse
all nodes of boundary of a grid creation area. Complete creation of arbitrary grid
border by mouse double click.

• to use vector layer polygons as areas of grid creation, perform the following actions:

1. Select Vectors › Create layer to create vector layer without classifier or load
layer with polygons which could be used as a grid boundaries.

2. Create a polygon in such a way that its boundary coincides with boundaries of
area which is used for grid creation.

3. [optional] Select polygons to be used as boundaries for a grid creation, otherwise,
a grid will be created considering all polygons of the layer.

4. SelectGrid › Create boundaries from vectors. After that created grid boundary
coincides with outline of created polygon.

• to create a grid for the whole images block without defining its boundaries, select
Grid › Properties, specify its parameters and click OK. Grid is created automatically
for the entire block and the grid boundary passes over external boundary of block
images.

When a grid boundary is defined the program creates a grid of nodes with specified or
default parameters.

In order to change parameters of created grid, select Grid › Properties. The Grid
properties window opens.
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Fig. 44. Regular grid parameters

The Grid properties window allows to setup the following parameters:

• X step and Y step – steps for nodes creation correspondingly by X and Y axes in
meters;

• Rotation – angle of nodes grid rotation in degrees;

Should be specified for manual work in the pathway mode.

At that, the nodes grid only is rotated. Area of nodes grid creation remains in initial position.

• Z level – a grid elevation above relief level (in meters) for visual correct display of
the grid;

• Ground sample distance (GSD) – shows a value of average pixel size in meters, if
a project contains adjustment results or pixel size is specified for at least one image.

To display a grid with specified parameters click theApply button. To change parameters
click OK.

To save created grid in active profile resources use Grid › Save and Grid › Save as
menu items. The grid is saved to the *.x-grid file.

To open existing grid, select Grid › Open. To close a grid, select Grid › Close. To close
all grid layers, select Grid › Close all opened layers.

Context menu of the Grid layer in the Manager duplicates save and load commands in
the Grid menu, and allows to close a grid layer.
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17.2. Points automatic calculating

17.2.1. Automatic calculating of points

The program provides possibility to calculate points automatically using correlator in
overlap areas of stereopair images by regular nodes grid.

Because of large processing data volumes in UAS projects, it is recommended to use
automatic calculating of points.

All selected stereopairs should be located on adjusted part of a block (see “Block adjustment”
User Manual), otherwise, points calculation is not performed or is performed incorrectly. In the
first case the system displays error message, in the second one – it is not possible to match
calculated points to project coordinate system.

Acquired points are used as a vector base for DEM generation. Additional possibilities
of points editing allow to obtain vector base for TIN creation and DEM generation.

The principle of automatic points calculation is as follows. For each selected oriented stereopair
the system performs automatic pass of all grid nodes, located in overlap area of stereopair im-
ages, and tries to calculate spatial coordinates in vicinity of each grid node using correlator. In
case of successful correlation the system performs accuracy control of each found point’s co-
ordinates, and after that the point is either added to vector layer as point object, or is excluded.
If the system fails to calculate spatial coordinates in vicinity of some grid node, the node is
skipped and the system passes to the next node.

Prior to start of automatic points calculation perform the following preparatory actions:

1. [optional] Define search area: select block stereopairs where to perform automatic
points calculation.

2. Create regular nodes grid for selected search area.

3. Choose Terrain › Points › Compute points automatically or click the Compute
points button on the Compute DEM tab of the main toolbar. The Compute points
window opens.

If a grid not was not created, it is created automatically for the entire images block and the
Grid properties window opens, that allows to specify grid parameters.
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Fig. 45. The “Compute points” window

4. In theCorrelator preset section select in the list one of the following types of terrain:

Correlator configuration – is a script of points calculation operation, that defined a number
of passes of regular grid nodes and a set of correlator parameters for each pass.

• mountainous terrain – for automatic points calculation on images with mainly
mountainous terrain with big elevation differences;

• urban areas – for automatic points calculation on images with mainly urban type
of build-up;

• desert – for automatic points calculation on images with monotonously deserted
terrain with rare vegetation;

• rural area – for automatic points calculation on images with rural areas with with
minor amounts of buildings and infrastructure;

• rural area 2 – for automatic points calculation for “rural” area with heterogeneous
parts of relief. If there are images with big intersection angle the configuration
uses a mask of larger size. Accuracy of points calculation is less then when using
rural area type.

To view and edit parameters values and to setup correlator configuration the list, to create
new or delete configurations from the list click the button.
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5. In the Search area section specify a search area, which will be used for automatic
points calculation:

• All images – allows to select all images of a block;

• Selected images – allows to select block images highlighted in 2D-window;

To view and change a set of highlighted images in block 2D-window click the button.

• Active stereopair – allows to select images of a stereopair opened in active 2D-
window.

All selected stereopairs should be located on adjusted part of a block (see “Block adjust-
ment” User Manual), otherwise, points calculation is not performed or is performed in-
correctly. In the first case the system displays error message, in the second one – it is
not possible to match calculated points to project coordinate system.

6. [optional] Points calculation is performed by default for strip stereopairs. To calculate
points for inter-strip stereopairs, formed by selected images set the Process inter-
strip stereopairs checkbox on.

7. [optional] To filter blunders by Z on images with intersection angle of small or null
value, set the Limit intersection angle checkbox on and define a value of minimal
angle using the slider.

8. [optional] In the Grid section the Area of the grid layer in m2, as well as Appr.
nodes count in a grid are displayed in appropriate fields. To change a grid layer
parameters click the Properties button.

To change grid boundaries it is necessary to close the Compute points window.

9. In the Initial approximation section specify initial value of Z coordinate of a grid
node for correlator work:

Initial approximation defines a value of Z coordinate of grid node, that is used to calculate
initial coordinates of point on the left and right images of a stereopair.

• Mean stereopair elevation –mean elevation of each stereopair, calculated using
exterior orientation parameters, is used as initial approximation;

• Fixed elevation – input elevation value in meters to be used as initial approxim-
ation;

• DEM – a value of elevation of selected DEM in point with XY coordinates of grid
node is used as initial approximation.
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If grid node falls into null cell of DEM, the system uses average elevation of cor-
responding stereopair. To select DEM in active profile resources click the
button.

To specify value of acceptable deviation of Z-coordinate of calculated points from
initial approximation set the Precision checkbox on and input value of acceptable
deviation in meters to the input field.

If the Precision checkbox is off, acceptable deviation is calculated automatically according
to selected configuration of correlator.

10. [optional] To thin nearest points, acquired during passing the same grid nodes on
different stereopairs, the Delete redundant points checkbox is on in the system
by default.

Thinning is performed after completion of points calculation operation according to specified
radius value, set by used correlator configuration.

When the Save quality assessment to attributes checkbox is on, points with minimal
correlation coefficient (minimal value of “corr” attribute) are removed from several found
nearest points.

11. [optional] To distribute points randomly in area of halfsize of grid cell from grid node,
set the Random points distribution checkbox on.

12. In the Destination section define parameters of loading and saving of calculated
points:

• Load into vector layer – allows to load points into active vector layer;

If there is no active vector layer, points are loaded to a new vector layer.

• Save into resources – allows to save points into active profile resources without
loading. Click the Settings button to specify parameters of points saving. The
Settings for saving points window opens.
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Fig. 46. The “Settings for saving points” window

To save points in one vector file of active profile perform the following actions:

1. Select the Save into one resource option and click the button. The
Save window opens.

2. Select a folder in the active profile resources and input a name of vector file
in theResource name field. Click OK to create a new vector file and to return
to the Settings for saving points window.

3. The input field of the Settings for saving points window shows path and
name of new vector file. Click OK to return to the Compute points window.

To save points in parts into several vector files of active profile perform the follow-
ing actions:

1. Choose the Split into parts option.

2. Select one of the ways of points splitting – By rectangular sheets and input
a size of rectangular area in meters or By stereopairs.

3. Input path to save file to the Save in folder field or click the button, to
select name and path in active profile resources to save points in parts to
corresponding vector files and click OK.

4. The input field of the Settings for saving points window shows path and
name of new vector file. Click OK to return to the Compute points window.

13. Click OK. The points calculation operation starts.

In some cases operation of automatic points calculation takes a lot of time.

To setup points calculation in distributed mode click the Distributed processing…
button and specify parameters of tasks distribution.
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17.2.2. Points calculation in distributed processing mode

To calculate points in distributed processing mode, perform the following actions:

1. Change settings and run the distributed processing server/client.

2. Choose Terrain › Points › Compute points automatically or click the Compute
points button on the Compute DEM tab of the main toolbar. The Compute points
window opens.

If a grid not was not created, it is created automatically for the entire images block and the
Grid properties window opens, that allows to specify grid parameters.

3. Setup parameters of automatic points calculation.

4. Click the Distributed processing button. The Compute points Distributed Pro-
cessing window opens.

Fig. 47. Parameters of distributed processing of points calculation

5. In the Split into tasks section select a way of splitting of processing operation into
tasks:

• By stereopairs – allows to process each stereopair in a separate task;

Since tasks are executed independently from each other, the system doesn’t remove
points, falling into the same grid nodes from different stereopairs (for example, during
filtering of nearest points).

• By rectangular sheets – it is necessary to specify in the fields a size of rect-
angles, into which the entire search area is split (in meters). Filtering of nearest
points is not performed in this case. The result of each task processing is saved
to the file with name like Sheet_X_Y.x-data.

Rectangle, circumscribing grid boundaries in project coordinates system, is split by
rectangular sheets of a size specified in the fields. Each sheet includes images parts
from all stereopairs, into which it falls.
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If stereopairs are processed in separate tasks, after that it is necessary to perform manual
data correction. Calculated points are saved in resources, named by stereopairs names.

The Tasks number field displays calculated number of tasks depending on selected
way of workflow split and/or size of specified areas.

It is not possible to define number of tasks manually.

6. In theWorking folder section click the button and select empty folder in active
profile resources to save output DEM.

Before operation is performed all data from selected folder is removed. It is strongly not
recommended to specify a project folder as a working folder, especially when there are no
saved project backups.

7. Click OK. Distributed processing tasks are created and the system shows amessage
about number of created tasks.

When using distributed points calculation, the result of each task is saved to separate file
with tsk extension in specifiedWorking folder of a project.

17.3. Points filtering

The system provides deletion, correction or recognizing points which have fallen on
buildings, trees, cars, in pits during automatic points calculation, and during filtering of
accident surges. For that filter of buildings and vegetation id used. After its work only
points that describe terrain relief are remain in the system.

In this document all points not lying on the relief surface (average smoothed terrain
surface), are called surges.

Filter of buildings and vegetation allows to apply step-by-step points filtering using
particular script, i.e. to apply points filtering in multiple passes with different parameter
sets.

It is possible to develop customized script of filter workflow or to use default script. Creating
script of buildings and vegetation filtering means specifying of passes set, order of their passing
and setup the parameters for each pass.

Step-by-step filtering allows to achieve optimal results of objects filtering on any type
of terrain to acquire points, that correctly describe terrain relief, and that could be used
to generate high quality DEM.

By default, the system uses standard script that includes three passes in the following
order:
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1. Basic – main pass with parameters configured for filtering points not lying on the
relief surface (surges). On this step the system rejects majority of points on buildings,
and also correlators blunders (sharp spikes).

2. Additional – additional pass with parameters configured for searching surges,
missed during basic step.

3. Detailed (off by default) – the pass with parameters configured for filtering points
located on low objects, such as small buildings, cars, and so on.

After filtering the system may perform the following actions with points found (surges):

• rejecting surges from initial points layer;

• correction of surges found on initial points layer, that means editing of surges Z-co-
ordinates;

• search for surges to analyse them with saving of found points to new vector layers
without changing initial points layer.

Fig. 48. Parameters of buildings and vegetation filter

The Buildings and vegetation filter window allows to specify filtering parameters and
setup a number of filter passes. The Layer field displays a name of active vector layer.
The window contains a standard toolbar.
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FunctionButtons
allows to load a script of filter work from *.x-filter
resource located out of active profile resources
allows to load a script of filter work from *.x-filter
resource located in active profile resources
allows to save a current script of filter work to *.x-
filter resource located out of active profile re-
sources
allows to save a current script of filter work to *.x-
filter resource located in active profile resources
allows to cancel all changes made to a script
allows to go back to a standard script that includes
two passes with default settings (regardless of which
script has been loaded)

To filter objects on surface perform the following actions:

1. Make active a points layer.

To avoid loss of data, it is recommended to use a copy of initial layer during filtering.

To create a copy select Vectors › Save as and specify new name of points file.

If a layer contains linear or area vector objects the filter may not work properly.

2. Select Terrain › Points › Filter › Buildings and vegetation filter. The Buildings
and vegetation filter window opens.
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Fig. 49. Parameters of buildings and vegetation filter

3. [optional] In order to use filtering for selected objects (points group), set the Filter
selected objects only checkbox on. Otherwise, filter is applied to all points of the
layer.

To filter a group of points, select it by mouse in 2D-window prior to start configuring the
buildings and vegetation filter.

When using filter for selected objects only, it is not recommended to set the Remove near
the border option in the Untestable points section.

4. [optional] To increase the filtering operation performance set the Copy points to
new layers before removing or correcting checkbox off. By default, the system
saves removed or corrected points in new vector layers used for analysis of filtering
results. These layers could be used to restore basic points layer (using operation
of layers merging), if the copy of initial points layer was not created prior to filtering
start.

If the Copy points to new layers before removing or correcting checkbox is off, it is
highly not recommended to apply filtering to initial points layer, since it is impossible to re-
store the initial layer after filtering.

5. In theUntestable points section specify one of the following actions with untestable
points found after filtering:
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Some points can be untestable – the points, in which vicinity there is not enough ’neighbour’
points. For example, points located on the edge of the whole layer or in areas of low
density of points (fields, forests, water bodies).

• Remove all – allows to remove all found untested points;

• Remove near the border – allows to set a value of distance in meters from the
edge of the whole vector layer, at which all untestable points will be removed.
The Distance from the border field is used to do this;

• Mark only – allows to save untested points to separate vector layer for further
analysis.

6. [optional] The Recalculate parameters for average distance between points in
the layer checkbox is set by default. After that the system calculates automatically
values of average distance between points in active layer. This leads to automatic
re-calculation of current parameters of each pass.

7. Specify a number of filter passes:

• by default it is used two passes with standard parameters –Basic andAdditional.
Set off checkboxes to change set of passes.

• the button allows to add a new pass of filter;

• the button allows to remove selected pass of filter;

• buttons and buttons allow to move selected pass up/down.

The Filter passes section contains a table of passes and buttons used to change
set of passes and their order with the following columns:

• Pass – displays pass name and checkbox used to include a pass to script or to
exclude it from filter workflow script;

• Reliable surges – displays action to be applied to well-defined surges found,
that are completely comply with specified filtering criteria;

• Doubtful surges – displays action to be applied to ambiguous surges found, in
which vicinity there is no data enough for analysis.

It is necessary to select an action to be applied to reliable and doubtful surges during
configuring of pass parameters.

8. Select a pass name and click the Edit pass parameters> > button. The Pass
section is opened and allows to display and configure the following parameters of
filter pass:
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Fig. 50. Parameters of buildings and vegetation filter

• [optional] to change name of pass, input a new one in the Name field;

• the Average distance between points in the layer (in meters) and Estimated
distance between points (in meters) after filtering are displayed in fields;

• specify Near and Far distance of points mutual influence in meters to define
the circle radius. In this area points are checking for errors;

Near distance of points mutual influence – is the average radius of a circle where
the points are located that are attributed to the same flat surface towering above the
terrain (e.g. a flat roof).

Far distance of pointsmutual influence – is the average distance from points attributed
to the flat surface towering above the terrain where the points attributed to the terrain
are located for sure.

It is recommended to set the near distance (minimum circle radius) value as 3-5 values
of Average distance between points in the layer parameter.
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Fig. 51. Near distance of points mutual influence (a) and far distance of points mutual influence
(b)

• specify the following filtering parametersUp (above surface) and/orDown (below
surface):

○ Filter surges – allows to select points to be filtered: points on surface (high
objects) and/or points below surface (pits);

For filter operating it is necessary to set at least one checkbox on.

○ Spikes only – is used to reject just sharp spikes above/below surface, that
are defined by values of the Threshold slope angle for spikes and Distance
of points parameters. The rest of parameters are not considered;

In an angle between three points exceeds in relation to selected measuring plane a
value of the Threshold slope angle for spikes parameter, then the surge is called
spike.

○ Threshold slope angle for spikes – allows to specify angle of slope in relation
to selected measuring plane (above and/or below surface) to define sharp
spikes;

○ Maximum area of flat surges – allows to define maximal area of plane surges
(above/below surface) – points groups, that form smooth surfaces and are
distant from some plane of neighbour points. Generally, the points are located
on buildings roofs, and are lying on the same plane;
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The filter is not applied to plane surface, which area exceeds the specified value.

○ Intermediate smoothing radius – allows to specify a sphere radius
(above/below surface), that defines a level of intermediate smoothing of surface;

○ Allowed point deviation from from smoothed surface – allows to specify
criterion, according which the filter is applied to all points with elevations that
differ from smoothed surface more then on specified value;

○ Maximum area of flat surges – allows to define maximal area of plane surges
(above/below surface) – points groups, that form smooth surfaces and are
distant from some plane of neighbour points.

The button allows to go back to a standard script that includes two passes with all
default settings (regardless of which script has been loaded)

9. In the Actions section specify actions for reliable and doubtful surges found after
any step of filtering:

• Delete – deleting of points found from base points layer;

• Correct – editing in base layer Z-coordinates of points found;

• Check – saving of found points in a new layer without change of base layer.

Reliable corrected surges – found well-defined surges that satisfy completely to
all specified filtering criteria.

Doubtful surges – ambiguous surges in which vicinity there is no data enough to
analyse filtering operation possibility.

If the Delete or Correct option is selected, the system allows to edit base points
layer.

In order to save deleted or corrected points to new layers it is recommended to set the
Copy points to new layers before removing or correcting checkbox on.

If theCheck option is selected the initial points layer remains unchanged, and found
reliable or doubtful surges are copied to a new layer Surges.

10. [optional] To use all cores of workstation CPU for calculation operation, the Use all
available CPU cores checkbox is set on in the system by default. It is necessary
to set the checkbox off to use only one core.
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11. Click OK. The system starts DEM filtering operation. When the filtering operation
is completed the system displays information message about number of used basic
points and filtered points.

There are the following recommendations concerning use of buildings and vegetation
filter:

• it is recommended to use step-by-step filtering (in multiple passes with different
parameter sets);

• the passes should be formed in ascending order of the following parameters: distances
of mutual influence, radius of intermediate smoothing, and decreasing of allowed
deviation of point from smoothed surface;

• value of intermediate smoothing radius directly describes terrain relief features, that
it why it is necessary to specify the radius value not exceeding 1500 meters;

• it is recommended to perform preliminary analysis of maximal area of flat surges on
given territory (to measure it in a stereopair window) and then to compare it with area,
calculated automatically for passes. If the measured area is bigger than calculated
one, it is necessary to increase it;

• it is highly not recommended to specify a distance of mutual influence of points ex-
ceeding a step between points in more than 20 times, since it leads to considerable
slowdown of filtering operation.

17.4. Building TIN

Perform the following actions to build TIN:

1. Choose the Terrain › TIN › Build... (Ctrl+N, T) or click the Build TIN button on
the Compute DEM tab of the main toolbar. The Create TIN window opens.
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Fig. 52. The “Create TIN” window

2. [optional] By default in the Source data section set on checkboxes for all opened
layers to use them in TIN creation. Set of checkboxes if there are open layers not
for TIN.

To select all available layers, click the button, to unselect all layers – click the button.
To invert selecting layers it is used the button.

3. [optional] In the Quasi-contours section the Display checkbox on and in the
Starting level filed specify minimal Z level (Zmin), from which to start quasi-contours
creation.

4. [optional] Set the Interval of quoasicontours in meters.
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5. [optional] In order to create quasi-contours as smoothed curves, set the Smooth
contours checkbox on and specify the smoothing parameters.

• Input the Curvature radius for smoothing curve.

• Specify in the input field the Precision parameter – maximal distance from
polyline segment to a curve in the area between the two closest vertices.

6. In the Border section set on the following:

• Convex – the convex border of TIN is created;

It is recommended to create convex border, when some part of vector objects does not
cover all area of TIN creation (for example, when there are lakes and rivers on large
scale images).

• Nonconvex – the nonconvex border of TIN is created;

It is recommended to place the Smoothing slider in the middle and smoothly move it
to the left to get the best results.

• Use polygons from layer – to create a TIN with convex border in limits of area
of polygon(s) selected in the layers list. Select from the list the layer with polygons,
which is used as a border. In order to define a border of TIN creation area, just
from selected polygons, set the Selected only checkbox on.

7. Click OK. The TIN is created in the new TIN layer.

18. Digital Elevation Model
Refer to the “DTM Generation” User Manual for the detailed information about generation of
digital elevation model (DEM).

18.1. The ’DEM’ menu

The DEM menu contains standard menu items used to load and save DEM layers, as
well as menu items used to perform various operations on DEM creation, accuracy
control, filtering and editing.

The DEM menu is located in the Terrain menu.

Table 17. Brief description of the “DEM” menu

FunctionMenu items
allows to load DEM from *.x-dem fileLoad DEM... (Ctrl+O, D)
allows to get quick access to the recently loaded
DEM files

Recent
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FunctionMenu items
allows to save opened DEM to a new fileSave copy
allows to save DEM areaSave selection
allows to close a DEM layerClose
allows to close all DEM layersClose all opened layers
contains menu items which allow to perform batch
management of TIN layers visibility in the Layer
manager

Layers visibility

contains menu items used to create DEM with help
of various source data

Build DEM...

contains menu items used to filter DEMs using dif-
ferent ways

Filter

contains menu items used to restore blank cells of
DEM using various methods

Fill null cells

contains menu items used to perform export of DEM
to different formats

Export...

contains items used to import DEM from files with
grd, asc, tif, dem, mtw, dt1, dt2, img, pix, hgt exten-
sions

Import...

contains the Additional menuAdditional

Table 18. Brief description of the “DEM” menu (Additional)

FunctionMenu items
allows to save a DEM as a raster file with geodetic
reference

Save as georeferenced raster...

contains menu items used to create DEM with help
of various source data

Build DEM...

allows to recreate DEM after changing of TIN base
layer

Rebuild by TIN

is used to restoring of DEM consistency, which may
be disrupted by applying various operations or DEM
filtering

Restore

allows to filter objects based on slope angleSlope based filter
allows to filter DEMs depending on image character-
istics

Filter by image properties

allows to convert DEM cells with specified elevation
to null ones

Convert cells to null

allows to set the same elevation of DEM cells inside
and outside of selected polygons

Set elevation in selected polygons...

allows to interpolate a value of DEM cells inside and
outside of selected polygons

Interpolate elevation in selected polygons...

is used to edit coverage area of DEMCut by selected polygons
is used to remove edge areas of DEM, that include
blank cells

Cut null edges
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FunctionMenu items
is used to transpose DEM from the left coordinate
system to the right one and vice versa

Transpose

allows to change coordinate system of DEMTransform to another coordinate system
allows to recreate DEM considering results of the
last adjustment (if the project was adjusted after
DEM creation once more)

Rebuild considering last adjustment

is used to parallel displacement of DEM by axesShift
allows to split DEM into sheet to save DEM in parts
in separate files

Split DEM into sheets

allows to create histogram by DEMCreate histogram by DEM
allows to merge DEMs, that have overlap areaMerge DEMs
is used to perform accuracy control DEM creation
using various data

Accuracy control

allows to calculate a volume (i.e. embankment or
excavation) located between DEM surface and ar-

Compute volumes

bitrary Z-plane or in a more complex case, the
volume which is the overlap between the two
(roughly, “top” and “bottom”) DEM surfaces.
allows to convert DEM cells to points with specified
simplifying

Convert to points...

allows to add points to DEM that helps to refine DEM
cells values

Write points to DEM...

is used to simultaneous import of multiple DEMBatch import

18.2. General information

DEM (Digital Elevation Model) – is digital cartographic representation of the earth’s
surface in the form of a regular grid of height values.

A source data for DEM creation is the following data, taken individually or in combination:

• TIN (Triangulated Irregular Network);

• regular or irregular points (point objects);

• vector objects (see the Vector objects creation chapter in the ’Vectorization’ User
Manual).

DEM is displayed in 2D-window, and also could be opened to view in 3D-window or in
2D-window of stereopair in stereo mode.

DEM in stereo mode may be displayed inaccurately.

To view information about DEM select Information item in the Manager. The system
displays information window which includes the following information about the layer:
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• layer name;

• full path to layer file;

• presence of data and changes in the layer;

• possibility to change the layer;

• coordinates of DEM border nodes, including Z-coordinate;

• ground sample distance;

• DEM size (number of cells);

• layer coordinate system.

Fig. 53. Information about DEM layer

18.3. DEM creation

18.3.1. DEM creation by TIN

The system provides possibility to create DEM using irregular spatial triangles network
(TIN). Perform the following actions to do this:

1. Create or load source TIN.

2. Choose Terrain › DEM › Build DEM › From TIN (Ctrl+N, D). The DEM by TIN
creation parameters window opens.
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Fig. 54. DEM by TIN creation parameters

3. Specify DEM borders in the North, West, East, South fields. In the Height and
Width fields the system displays calculated size of DEM border in meters.

Default values are coordinates of rectangle corners, which generate TIN creation area.

4. In the Cell size specify the DEM cell size in meters to define cell size of output
DEM. The Cells number, calculated considering specified cell size, displays in the
Height andWidth fields. Also theApproximately DEM size in megabytes displays
in the appropriate field.

DEM cell size should be comparable to average distance between points of base TIN
layer. If less cell size is used, the time of DEM creation and size of output file increase, but
accuracy is not.

Click the From project button to setup DEM cell size that equals to average GSD value
in the project.

5. [optional] It is possible to use parameters of existed DEM to calculate parameters
of output DEM. To do that, click theCalculate parameters by existing DEM button
and choose DEM file in active profile resources.

6. Click OK. Specify DEM file name, define a folder in active profile resources and
click Save. The system starts DEM creation operation. After that the system creates
new layer in the Manager and shows a message about operation successful or
unsuccessful completion.
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Fig. 55. DEM built from TIN

Whenmarker is moving over DEM, the status panel in 2D-window displays XYZ-coordin-
ates of DEM points.

The system allows to recreate DEM after changing of TIN base layer. To do this use
the Terrain › DEM › Additional › Rebuild by TIN menu item.

18.3.2. Dense DEM generation using SGM method

The system provides possibility of generation of dense digital elevation model (DTM)
using SGM method.

DEM creation using dense model is executed for adjusted images block only (see “Block adjust-
ment” User Manual). Otherwise the DEM generation is not performed or is performed incorrectly.

Before generating dense DSM by SGMmethod in Pushbroom scanner imagery types of projects
(see the “Satellite scanner imagery” chapter of the “Creating project” User Manual) it is recom-
mended to build useful areas (see the “Building useful areas” chapter of the “Creating project”
User Manual).

For dense DEM generation using SGMmethod the system allows the following workflow:

1. DEM generation for a predetermined area.
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2. Main processing: applying buildings and vegetation filters to created DEM and/or
performing empty cells restoring.

3. [optional] Additional processing — median and/or smoothing filtering.

If intermediate data is not deleted after operation completing, the system allows to run in-
dividual stages of the processing (filtering and smoothing) without re-calculation of the
source DEM.

4. [optional] Point cloud (LAS) generation for an area limited by DEM boundaries;

5. [optional] True Ortho creation for an area limited by DEM boundaries.

To generate dense digital elevation model using SGM method perform the following
actions:

1. Specify a grid to define DEM creation area.

Since the coordinates calculation is performed in each pixel of the selected area, the grid
nodes are not considered. The grid is used just as a border of DEM creation area.

2. Select Terrain › DEM › Build DEM › Dense DSM (SGM method).... The SGM
parameters window opens.

If a grid not was not created in advance, the Grid properties window opens, that allows
to create a grid for the entire images block.
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Fig. 56. SGM parameters

3. In the Search area section define one of the following searching areas:

• All images – allows to select all images of a block;

• Selected images – allows to select block images highlighted in 2D-window;

• Active stereopair – allows to select images of a stereopair opened in active 2D-
window.

All selected stereopairs should be located on adjusted part of a block (see “Block adjust-
ment” User Manual). Otherwise, the calculation is not performed or is performed incor-
rectly. In the first case the system displays error message, in the second one – it is not
possible to match calculated points to project coordinate system.

4. [optional] Specify additional parameters of search area:

• set the Process interstrip stereopairs checkbox on to calculate DTM on inter-
strip stereopairs during UAS projects processing. This option is also used in
cases where source images geometric and radiometric parameters allow to use
inter-strip stereopairs.
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By default DEM generation is performed for strip stereopairs (recommended method).
For DEM creation in Vision Map projects it is recommended to use strip stereopairs
only.

• set the Limit intersection angle checkbox on to filter blunders by Z on images
with intersection angle of small or null value, and define a value of minimal and
maximal angles;

To evaluate intersection angles in the images of the project, perform the following:

1. Create a “stereo quality” map for the block of images (see Section “Creation of
“stereo quality” map” in the “Vectorization” User Manual). .

2. Change “stereo quality” map coloring according to the st_ang attribute values
(Vectors › Attributes › Color by attribute value, see Sections “Creation of “stereo
quality” map” and “Custom object paint” in the “Vectorization” User Manual).

3. To obtain information on the st_ang attribute value for the selected stereo quality
map node, select the appropriate stereo quality map node and choose Window ›
Objects attributes.

5. In the Initial approximation section select a method of heights range calculation
for DEM generation:

• Stereopair heights range – heights range is calculated for each stereopair indi-
vidually using heights of project tie points measured earlier;

• Project heights range – heights range is taken from the Relief elevation value
in project properties or is calculated using heights of project points measured
earlier;

• Manual height – input a height value in meters to be used as initial approximation;

The Range extension field allows to increase height range by a predetermined
value to create a DEM. If the Manual height mode is on the option specifies
working range of heights (search area).

6. In the Working folder section click the button and choose an empty target
folder in active profile resources to save the output DEM.

The system removes all data from the target folder prior to perform the save operation.

The name of output DEM is final_dem.x-dem (automatically set). The name of output DEM
with filled null cells (see paragraph 12) is final_dem_tmp.x-dem (automatically set).

7. In the SGM parameters section select the cost calculation method:
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• CT – method selected by default;

• MI – method is less sensitive to non-linear values of images brightness, but more
demanding in performance (duration of DEM generation becomes 2-3 times
longer).

8. [optional] Setup the Maximum vertical parallax value.

9. For more detailed settings of SGM cost calculation click Additional.... The SGM
parameters window opens.

Fig. 57. SGM parameters

DescriptionParameters
Specifies a size of parts that epipolar images will
be splitted to. The parameter’s value affects pro-
cessing performance.

To limit area of calculation

Number of calculation directions. It affects DEM
accuracy and generation time. Recommended
values: 8, 16, 32.

Paths number

Penalty for parallax change by 1 pixel. It is recom-
mended to increase this value when using extens-

Penalty 1

ively noisy images. The value may be reduced to
improve the accuracy of the DEM when using
qualitative data.
Penalty for parallax change by more than 1 pixel.
It is recommended to increase this value when

Penalty 2

using extensively noisy images. The value may
be reduced to improve the accuracy of the DEM
when using qualitative data.
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DescriptionParameters
Parameters used just for calculation byMImethod
(see above). Defines smoothing level of epipolar
images histogram.

Histogram smoothing radius

Half-size of rectangular correlation mask in pixels
by X and Y axes.

Pixel cost calculation radius

Interpolation distance when auto-filling missed
results («holes») by adjacent pixels.

Disparity map interpolation

Minimal overlap area of epipolar image parts in
pixels. Recommended value: not less than 20.

Minimum area of overlapping

Median filter radius used for filtering of parallaxes
map of individual stereopair.

Median filter radius

Smoothing filter parameter used to epipolar im-
ages preprocessing.

Image smoothing radius

Allows us to delete isolated DEM areas (having
sizes lesser than set ones) during individual pro-
cessing of each stereopair

Filter DEM errors

Isolated DEM areas – the cells with values beyond the boundaries of the main DEM or
among null cells.

10. [optional] In the Auxiliary processing section specify the following filtering para-
meters:

• set the Median filter checkbox to use median filtering during DEM creation and
specify parameters of filter usage;

• set the Smooth filter checkbox to use smooth filtering during DEM creation and
specify parameters of filter usage.

• specify the Minimum number of counts in overlapped area parameter value
to setup counts reliability in DEM.

This parameter determines the minimum number of overlapped stereopairs required for
calculating the resulting DEM cell value.

The cell of the final DEM will be recorded if the number of overlapped stereopairs used
for its calculation is equal to the preset value (or exceeds it).

Correct choice of this parameter value depends on minimum stereopair overlap in a
block and on using interstrip stereopairs during DEM calculation (see paragraph 4).

Recommended default value is 2. In case of a small overlap of stereopairs, it is recom-
mended to lower the value of the Minimum number of counts in overlapped area to
1.

To estimate stereopair overlap area in the project, choose Block › Create overlap
map... (see “Creating overlap map” of the “Creating project” User Manual).
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Function Block › Create overlap map... allows only to estimate stereopair overlap in
the project, since map creation is carried out for images but not for stereopairs.

11. [optional] Set the Create point cloud (LAS) checkbox to record a LAS file with a
point cloud (see the “LIDAR Data processing” User Manual). For more detailed
setting of point cloud creation parameters, click Parameters... button. The LAS
creation parameters window opens:

This function is available only for projects of the “Central projection” type (see the “Project
types” chapter of the “Creating project” User Manual).

If the Create point cloud (LAS) checkbox is set, it is recommended to use the distributed
processing mode for dense DTM creation using the SGM method.

Points cloud will be saved in the separate LAS directory in the folder chosen for output
DEM saving in the active profile’s resources.

Fig. 58. The “Create LAS parameters” window

• Set Minimum and Maximum intersection angle in degrees;

To evaluate intersection angles in the images of the project, perform the following:

1. Create a “stereo quality” map for the block of images (see Section “Creation of
“stereo quality” map” in the “Vectorization” User Manual). .

2. Change “stereo quality” map coloring according to the st_ang attribute values
(Vectors › Attributes › Color by attribute value, see Sections “Creation of “stereo
quality” map” and “Custom object paint” in the “Vectorization” User Manual).

3. To obtain information on the st_ang attribute value for the selected stereo quality
map node, select the appropriate stereo quality map node and choose Window ›
Objects attributes.

• Set Point cloud density in meters;

By default, Point cloud resolution is twice as large as the DEM cell size (see below).

It is not recommended to set Point cloud resolution lesser than the DEM cell size.
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• Specify the Number of returns – the minimum number of stereopairs required
for point calculation;

• Set theDelete points above DSM checkbox to remove points above DEM. Enter
the permissible elevation above the DEM surface, in meters.

Hence, when the LAS point cloud creating, all points above the DEM surface will
be removed, except for those not exceeding the given permissible elevation;

Too low or zero values of the permissible elevation may cause removal of “good” points,
and hence, “sparse” point cloud.

Recommended value is no less than RMS by Z in stereopairs (see the “Brief residuals
report” chapter in the “Block adjustment” User Manual).

This function is identical to the Delete points above › DEM function in the Filter LAS
window (See the “LIDAR data filtering” chapter of the “LIDAR Data processing” User
Manual).

12. [optional] in the True Ortho section, set the Create True Ortho checkbox to create
true ortho limited by DEM boundaries. The true ortho will be created in the work
folder (see above), in the PHOTOMOD MegaTIFF (*.prf) format;

Creating the true ortho will notably (approximately 2-fold) increase the time required for
DEM creation.

PHOTOMOD GeoMosaic program allows to save later the obtained true ortho in any of
available formats (see the “Orthophotomaps creation” User Manual).

The name of output orthoimage is final_ortho.prf (automatically set). The name of output
orthoimage with interpolated null areas is final_ortho_tmp.prf (automatically set).

For more detailed setting of true ortho creation options, click the Parameters…
button. The Fill NULL cells window opens.
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Fig. 59. The “Fill NULL cells” window

• In DEM section, set Minimum building height in meters to exclude buildings
from interpolation of DEM null cells (see the figure below);

• In DEM section, set Cache size when filling option in megabytes – maximum
cache size allocated for a single task when creating true ortho;

• In the True Ortho section, set the Global brightness adjustment checkbox to
apply global brightness adjustment over image overlapping areas when creating
an orthophotomap. For more detailed setting of brightness adjustment options,
click the Parameters… button. The Parameters window opens:

Fig. 60. Brightness adjustment parameters
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The opening window allows us to change the following settings of global brightness
adjustment:

○ Use statistic of overlapped areas with weight – allows to use the weight of
the images’ overlapping areas only;

○ Use statistic of entire images with weight – allows to use the weight of all
the pictures in the block;

If the images’ brightness in a block significantly differ, it is recommended to set a
small value.

○ Fix outline images with weight – allows the user to omit global alignment for
pictures on the block borders;

See the detailed description of brightness adjustment processes when creating an or-
thophotomap in the “Orthophotomaps creation” User Manual.

• [optional] clear the Fill NULL cells checkbox in the True Ortho section in order
not to fill null cells when creating a DEM (what can lead to creation of unfilled
areas when creating an orthophotomap) or specify the following parameters:

○ Overwrite valuable cells in NULL areas – allows to exclude isolated DEM
areas from interpolation of DEM null cells (i.e. interpolate these areas as a
NULL cells);

Isolated DEM areas – the cells with values beyond the boundaries of the main DEM
or among null cells.

○ Interpolate not filled NULL cells – allows to interpolate unfilled DEM/ortho-
photomap areas;

○ Fill single NULL cells – allows to interpolate areas without data having one
pixel size in a DEM or orthophotomap;

○ Visibility distance – the distance within which the visibility of points located
in unfilled areas of an orthophotomap is checked in the project’s images;

○ Visibility step – an increment with which the visibility of points located in unfilled
areas of an orthophotomap is checked in the project’s images;

○ Maximum images per pixel – maximum number of images of the project
where the visibility of points located in unfilled areas of an orthophotomap is
checked;
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○ Filter outliers – allows to perform orthophotomap median filtering with preset
Threshold. The statistics is collected in the neighborhood whose area is de-
termined by the Aperture size. This filter is used for removing single pixels
with unnatural brightness.

• [optional] set the Overwrite existing DTM/TrueOrtho checkbox in order not to
use intermediate data from the working folder (if DEM and orthophotomap has
already been created) but overwrite them.

Fig. 61. An example of unfilled area on true ortho, where a is the building height (see Minimum
building height parameter), b is the “isolated DEM area” among DEMNULL cells (seeOverwrite
valuable cells in NULL areas checkbox), с is the Visibility step, R is the Visibility distance,
S is the unfilled DEM/orthophotomap area (due to the fact that the image is the central projection
of terrain and objects towering above the Earth surface hide some terrain areas, thus they are
not seen on the image). Also, the quality of an orthophotomap is affected by the zones hidden

by the object’s shadow, and brightness adjustment is required.

13. [optional] in the 3D-TIN section, set theCreate 3D-TIN checkbox to create textured
3D-TIN surface limited by DEM boundaries. The 3D-TIN will be created in the work
folder (see above), in the *.tx3 format;

For further work with 3D-TIN, the PHOTOMOD 3D-Mod program is used (see more details
in the “Three-dimensional modeling” User Manual).

The name of output 3D-TIN is tin.tx3 (automatically set).

For more detailed setting of 3D-TIN creation options, click the Parameters… button.
The Creation 3D-TIN by DEM window opens.
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Fig. 62. The “Creation 3D-TIN by DEM” window

• In the Simplification section, select the method of simplification of the source
3D-TIN surface built by the input DEM:

○ Accuracy criteria – set the Minimum number of triangles in the final 3D-
TIN and its maximum allowable Deviation from source surface, in meters;

○ Quantity criteria – set theMaximumnumber of triangles in the final 3D-TIN.

• [optional] In the Tiles section, set the Split by parts checkbox, to split the 3D-
TIN surface and its textures into fragments;

To increase the system’s performance, it is recommended to set the Split by parts
checkbox when creating 3D-TIN for large areas.

○ In the Tile size field, set the size of 3D-TIN texture fragments, in pixels;

○ In the Tile overlap field, set the 3D-TIN fragment overlap, in pixels.

It is not recommended to set null overlaps.

• [optional] In the Textures section, set the Build textures checkbox to create a
textured 3D-TIN surface:

○ Set the Texture size;

It is recommended to set the Texture size exceeding the Tile size at list twice. In-
creasing of this parameter results in increased texture resolution and increased time
of 3D-TIN building.
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○ [optional] Set the Brightness adjustment checkbox to adjust brightness
between triangle textures;

• [optional] To use all cores of workstation CPU for calculation operation, the Use
all available CPU cores checkbox is set on in the system by default. It is neces-
sary to set the checkbox off to use only one core.

14. [optional] To remove processing data after the calculation is completed set the
Delete intermediate data checkbox on. Click the (estimate the size) button to get
information about disk space occupied by intermediate data.

It is not recommended to remove intermediate data up to final creation of DEM. After re-
moving of intermediate data it is impossible to start separate steps (filtering or smoothing)
without DEM re-calculation.

15. In the Output DEM parameters section specify DEM boundaries in the North,
West, East, South. In the Height andWidth fields the system displays calculated
size of DEM border in meters.

16. Specify DEM cell size in meters to change size of output DEM cell. In the Height
andWidth fields of the Cell size section the system displays nodes number calcu-
lated with specified DEM cell size. There is also displayed the Appr DEM size in
megabytes.

The value of the DEM cell size parameter should not be less than average pixel size
(GSD). When using cell size with smaller size the time of DEM creation and a size of output
file are increasing, however, the processing accuracy is not improved at that.

Click the From project button to setup DEM cell size that equals to average GSD value
in the project.

17. [optional] In order to calculate parameters of output DEM using parameters of the
existing DEM, click the Calculate parameters by existing DEM button and select
file with DEM in active profile resources.

18. Click OK to start dense DEM generation operation in normal mode.

In order to generate DEM using distributed processing, perform the following actions:

While building DSM by SGM method in distributed processing mode, stereopairs are pro-
cessed separately in different tasks (see the Searching area section). The last task is re-
sponsible for merging data acquired.

1. Start the server/client of distributed processing mode (see the “Distributed
processing” chapter in the “General information” User Manual).

2. Open theMonitor for distributed processing and specify theMaximum tasks
quantity value not more than one for each client.
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3. Click the Distributed processing... button.

Depending on the size of creation area the operation can take a long time.

To provide a system performance while building dense DSM by SGM method it is recom-
mended to use Distributed processing mode.

18.4. DEM filtering

The system allows to filter DEMs. The following filters are provided for editing DEMs:

• Building and vegetation filter as well as Slope based filter are designed for searching
and correcting DEM areas that cover buildings, vegetation, man-made objects and
accident spikes. As a result of filtering DEM contains heights of “true relief” only;

• Мedian filter and Smooth filter are designed for filtering accident spikes – points that
are placed far from the average smooth relief surface. As a result of filtering DEM
contains heights of “true relief” only;

• Filter by image texture is designed for deleting areas of DEM depending on charac-
teristics of image texture. At the preliminary step (so-called «Learning») an operator
manually collects specific areas of images as samples for filtering

18.4.1. Buildings and vegetation filter

The system allows to use filtering of buildings and vegetation of DEM. Such filtering
includes calculation of base points with specified coefficient of DEM subsampling. The
operation includes deletion, correction or recognizing points which have fallen on
buildings, trees, cars, in pits, etc. during automatic points calculation, as well as filtering
of accident spikes. After the filtering output DTM contains just terrain relief model.
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Fig. 63. Buildings and vegetation filtering from DEM

The Buildings and vegetation filter window allows to specify filtering parameters and
setup a number of filter passes. The Layer field displays a name of active vector layer.
The window contains a standard toolbar.

FunctionButton
allows to load a script of filter work from *.x-filter
resource located out of active profile resources
allows to load a script of filter work from *.x-filter
resource located in active profile resources
allows to save a current script of filter work to *.x-
filter resource located out of active profile re-
sources
allows to save a current script of filter work to *.x-
filter resource located in active profile resources
allows to cancel all changes made to a script
allows to go back to a standard script that includes
two passes with default settings (regardless of which
script has been loaded)

To filter buildings and vegetation on DEM perform the following actions:

1. Make active a DEM layer.

2. Select Terrain › DEM › Filter › Buildings and vegetation filter. The Buildings
and vegetation filter window opens.
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Fig. 64. Buildings and vegetation filtering from DEM

3. In the Output DEM section click the button and specify name and target folder
of output DTM in active profile resources.

4. [optional] Specify a number of filter passes:

• by default it is used two passes with standard parameters –Basic andAdditional.
Set off checkboxes to change number of passes;

• the button allows to add a new pass of filter;

• the button allows to remove selected pass of filter;

• the and buttons allow to move selected pass up/down.

5. Select a name of pass and click the Edit pass parameters button to display and
configure the following parameters of filter pass:
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Fig. 65. Configuration of buildings and vegetation filter

• [optional] to change a filter pass name, input new name to the Name field;

• the Source DEM cell size field shows DEM cell size in meters before filter apply-
ing;

• specify Thinout coefficient for calculating basic points by DEM. From the
specified value and the Source DEM cell size parameter depends the Space
between basic points parameter in meters;

• specify Near and Far distance of mutual points influence in meters to define
the radius of the circle, in which the values of points are analysed for errors. For
near distance (minimal circle radius) it is recommended to set a value of 3-5
values of the average distances between points;

• specify the following filtering parametersUp (above surface) and/orDown (below
surface):

○ Filter surges – allows to select points to be filtered: points on surface (high
objects) and/or points below surface (pits);

For filter operating it is necessary to set at least one checkbox on.

○ Spikes only – is used to reject just sharp spikes above/below surface, that
are defined by values of the Threshold slope angle for spikes and Distance
of points parameters. The rest of parameters are not considered;
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In an angle between three points exceeds a value of the Threshold slope angle for
spikes parameter, then the surge is called spike.

○ Threshold slope angle for spikes – allows to specify angle of slope in relation
to selected measuring plane (above and/or below surface) to define sharp
spikes;

○ Maximum area of flat surges – allows to define maximal area of plane surges
(above/below surface) – points groups, that form smooth surfaces and are
distant from some plane of neighbour points. Generally, the points are located
on buildings roofs, and are lying on the same plane;

The filter is not applied to plane surface, which area exceeds the specified value.

○ Intermediate smoothing radius – allows to specify a sphere radius
(above/below surface), that defines a level of intermediate smoothing of surface;

○ Allowed point deviation from from smoothed surface – allows to specify
criterion, according which the filter is applied to all points with elevations that
differ from smoothed surface more then on specified value.

The button allows to go back to a standard script that includes two passes with all default
settings (regardless of which script has been loaded).

6. [optional] To use all cores of used computer, the Use all available CPU cores
checkbox is set on in the system by default. It is necessary to set the checkbox off
to use only one core.

7. Click OK. The system starts DEM filtering operation. When the filtering operation
is completed the system displays information message about number of used basic
points and points being filtered.
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Fig. 66. Filtering results

18.4.2. Median filter

The system allows to use median filtering of DEM cells.

The median filtering contains the following sequence of actions:

1. Sequential scanning of DEM by mask with specified size. Size of scanning mask
is defined by the Aperture parameter (in DEM cells).

2. The system replaces current cell elevation values by median values, if a difference
between them is not more than specified Threshold in meters.

To apply median filtering perform the following actions:

1. Make active a DEM layer.

2. Select Terrain › DEM › Filter › Median filter. TheMedian filter parameterswindow
opens.

Fig. 67. Median filter parameters
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3. In the Threshold field specify a value of threshold in meters, which is used to
compare difference value between current and median elevation.

4. In the Aperture field specify a size of scanning mask.

5. Click OK. After that current values of DEM cells are replaced by median values, if
difference value between current and median elevation does not exceed specified
Threshold.

To use distributed processing for DEM median filtering, do the following:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing button. The DEM distributed processing
window opens.

Fig. 68. Parameters of distributed DEM filtering

3. The number of DEM parts, which the DEM is split on during distributed pro-
cessing, is calculated automatically and depends on the size of the matrix. It
is recommended to specifyNumber of fragments per task assuming one task
per one computer.

4. Select the Temporary folder for distributed processing for temporary data
storing.

5. Define the output file name and path.

6. Click OK. Distributed processing tasks are created and the system shows a
message about number of created tasks.

18.4.3. Smooth filter

The system allows to use smooth filtering of DEM cells values.
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To execute smooth filtering perform the following actions:

1. Make active a DEM layer.

2. Select Terrain › DEM › Filter › Smooth filter. The Smooth filter parameters
window opens.

Fig. 69. Smooth filter parameters

3. In the Level field specify filtering coefficient value from 0 to 1.

4. In the Aperture field specify a size of scanning mask.

5. [optional] To apply Gauss smoothing algorithm theGaussian filter checkbox is set
on by default.

6. Click OK. After that current values of DEM cells elevation are replaced by filtered
values.

To use distributed processing for DEM smooth filtering, do the following:

1. Change settings and run the distributed processing server/client (see the “Dis-
tributed processing” chapter in the “General information about system” User
Manual).

2. Click the Distributed processing button. The DEM distributed processing
window opens.
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Fig. 70. Parameters of distributed DEM filtering

3. The number of DEM parts, which the DEM is split on during distributed pro-
cessing, is calculated automatically and depends on the size of the matrix. It
is recommended to specifyNumber of fragments per task assuming one task
per one computer.

4. Select the Temporary folder for distributed processing for temporary data
storing.

5. Define the output file name and path.

6. Click OK. Distributed processing tasks are created and the system shows a
message about number of created tasks.

18.5. Null cells in DEM

18.5.1. General information

During automatic creation of regular relief model (DEM) some part of the cells can not
be defined. Such DEM cells (’gaps’), which elevation is not known, are called null cells.

The system provides possibility to restore null cells of DEM using the following methods
of null cells filling:

• linear interpolation method (see the “DTM Generation” User Manual);

• smooth interpolation method (see Section 18.5.2);

• filling with constant value (see the “DTM Generation” User Manual).

• filling with minimum value (see Section 18.5.3).

The system also allows to transform DEM cells with specified elevation to null cells.
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Filling DEM null cells is also used to change input DEM cell size.

18.5.2. Filling null cells using smooth interpolation

The system provides possibility to restore null cells of DEM using the smooth interpolation
method. When applying the method of smooth interpolation the system evaluates the
factor of input DEM thinning to obtain auxiliary DEM. An auxiliary DEM is used to calcu-
late elevation values of null cells, and DEM cells with filled elevations are not re-calcu-
lated. Borders and cell size of output DEM are fully correspond to the boundary and
the cell size of the input DEM.

This method is recommended for a sufficiently dense DEM.

To fill DEM null cells by smooth interpolation method perform the following methods:

1. Select Terrain › DEM › Fill null cells › Smooth interpolation.... The Parameters
of filling null cells in DEM window opens.

Fig. 71. Parameters of filling null cells using smooth interpolation

The window displays the ground sample distance (GSD) of input DEM in meters.
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2. In the Input DEM section click the button to select input DEM in active profile
resources.

The DEM loaded to the project is selected by default.

3. [optional] To define name and target folder of output DEM in active profile resources,
click the button.

By default the system suggests the <input dem name>_filled.x-dem name for output DEM
and to place it to the folder, containing input DEM file.

4. Input the Auxiliary DEM subsampling. After that the GSD of auxiliary DEM is
calculated automatically.

5. [optional] In the DEM border section, set the Select from layer checkbox to set
border of the output DEM using a vector polygon.

It is required to create in advance a vector layer with one polygon which sets borders of
the output DEM.

From the opened list of downloaded vector layers, select one vector layer that
contains a polygon limiting a DEM;

6. [optional] In the DEM border section, set the Build checkbox to create borders of
the output DEM automatically;

7. [optional] To remove processing data after the calculation is completed set the
Delete intermediate data checkbox on;

8. Click OK. The system starts calculation of null cells elevation using smooth interpol-
ation method. After that the system creates new DEM layer in the Manager.

18.5.3. Filling null cells by minimum values

The system provides possibility to fill null cells of DEM by minimum values.

The system also provides possibility to interpolate areas without data on orthophotomap (true
ortho) created together with the DEM.

To fill DEM null cells with minimum values perform the following:

1. Select Terrain › DEM › Fill null cells › By minimum values.... The Fill NULL cells
window opens.
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Fig. 72. Parameters of filling null cells of DEM by minimum values

2. In the DEM section click the button to select input DEM in active profile re-
sources.

3. [optional] To define name and target folder of output DEM in active profile resources,
click the button.

4. In DEM section, setMinimum building height in meters to exclude buildings from
interpolation of DEM null cells (see the figure below);
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5. InDEM section, setCache sizewhen filling option in megabytes – maximum cache
size allocated for a single task when creating true ortho;

6. [optional] In DEM section, сlear the Fill single NULL cells checkbox in order not
to interpolate single DEM NULL cells;

7. [optional] In True Ortho section, clear the Fill NULL cells checkbox in order not
to interpolate unfilled areas on orthophotomap;

8. In the True Ortho section click the button to select input true ortho in active
profile resources.

For correct work of interpolation algorithm it is required to select the orthophotomap that
was created together with the DEM in the same boundaries (see step 2).

9. [optional] To define name and target folder of output true ortho in active profile re-
sources, click the button.

10. [optional] Set the following parameters of unfilled areas interpolation on orthopho-
tomap:

• Overwrite valuable cells in NULL areas – allows to exclude isolated DEM areas
from interpolation of unfilled true ortho areas;

Isolated DEM areas – the cells with values beyond the boundaries of the main DEM or
among null cells.

• Interpolate not filled NULL cells – allows to interpolate unfilled orthophotomap
areas;

• Fill single NULL cells – allows to interpolate areas without data having one pixel
size on orthophotomap;

• Visibility distance – the distance within which the visibility of points located in
unfilled areas of an orthophotomap is checked in the project’s images;

• Visibility step – an increment with which the visibility of points located in unfilled
areas of an orthophotomap is checked in the project’s images;

• Maximum images per pixel – maximum number of images of the project where
the visibility of points located in unfilled areas of an orthophotomap is checked;

• Filter outliers – allows to perform orthophotomap median filtering with preset
Threshold. The statistics is collected in the neighborhood whose area is determ-
ined by the Aperture size. This filter is used for removing single pixels with un-
natural brightness.
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11. [optional] set theOverwrite existing DTM/TrueOrtho checkbox in order not to use
intermediate data from the working folder but overwrite them.

Fig. 73. An example of unfilled area on true ortho, where a is the building height (see Minimum
building height parameter), b is the “isolated DEM area” among DEM NULL cells (see Overwrite
valuable cells in NULL areas checkbox), с is the Visibility step, R is the Visibility distance, S
is the unfilled DEM/orthophotomap area (due to the fact that the image is the central projection of
terrain and objects towering above the Earth surface hide some terrain areas, thus they are not

seen on the image).

12. Click OK. The system starts filling of null cells operation. After that the system dis-
plays a message about number of changed cells and creates new DEM layer in
the Manager.

To use distributed processing for DEM null cells filling, do the following:

1. Change settings and run the distributed processing server/client (see the ’Dis-
tributed processing’ chapter in the ’General information about system’ User
Manual).

2. Click the Distributed processing button. The DEM distributed processing
window opens.

135

Processing of UAS dataPHOTOMOD 6.4

general.pdf


Fig. 74. DEM distributed processing

3. The number of DEM parts, which the DEM is split on during distributed pro-
cessing, is calculated automatically and depends on the size of the matrix. It
is recommended to specifyNumber of fragments per task assuming one task
per one computer.

4. Select the Temporary folder for distributed processing for temporary data
storing.

5. Click OK. Distributed processing tasks are created and the system shows a
message about number of created tasks.

19. Contour lines
Refer to the “DTM Generation” User Manual for the detailed information about contours gener-
ation.

19.1. The “Contours” menu

The Contoursmenu contains usual menu items used for contours generating, editing,
import and export.

The Contours menu is located in the Terrain menu.

Table 19. Brief description of the “Contours” menu

FunctionMenu items
allows to load contour lines from *.x-data file (see
the “Vectorization” User Manual)

Load... (Ctrl+O, V)

allows to perform the quick access to recently
loaded contour lines

Recent

allows save or rewrite active contours layerSave
allows to save active layer with new nameSave as...
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FunctionMenu items
allows to save just selected contoursSave selected as...
allows to close contour lines layerClose
contains menu items used to create contour lines
with help of various source data

Build contours

contains items used to import contour lines from
files with different extensions (see the “Import of

Import

vector objects” chapter of the “Vectorization” User
Manual)
contains menu items used to perform export of
contour lines to files with different extensions (see

Export

the “Export of vector objects” chapter of the “Vector-
ization” User Manual)
contains the Additional menuAdditional

Table 20. Brief description of the “Contours” menu (Additional)

FunctionMenu items
contains menu items used to create contour lines
with help of various source data

Build contours

allows to check created contours for crossing/self-
crossing, that occur after operation of contours
smoothing

Check contours intersections...

allows to perform quality control of contours creation
using regular points, if they were not used for con-
tours creation

Check contours by points

allows to merge created contours in automatic or
manual mode

Merge contours...

allows to check contours for breaks that occur after
manual or automatic contours merging

Check merging contours...

allows to connect created contours automatically or
manually (without merging into a single vector ob-
ject)

Contours connecting

allows to check elevations of created contours ver-
tices

Check contours vertices

allows to set a precision of vector objects coordin-
ates at level of decimal places

Precision of objects coordinates

19.2. Generation contour lines by DEM

The system provides possibility to create contour lines by digital elevation model (DEM).

In order to build contours using DEM perform the following actions:

1. Load a DEM layer.

2. [optional] Create and select one or multiple vector polygons, if it is needed to build
a contours inside selected polygons;
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3. Choose Terrain › Contours › Build contours › From DEM.... The Contours cre-
ation parameters window opens.

TheDEM parameters section displays information about elevation difference (Min.
elevation, Max. elevation) in DEM.

Fig. 75. Parameters of contour lines generation by DEM

4. [optional] In order to create contours as smoothed curves it is needed perform op-
eration of DEM smoothing prior to contours creation. To do this set the Smooth
checkbox on in the DEM section. Specify smoothing level in the Smooth level field
(maximal smoothing is applied at 1 value).

During smoothing the system uses information about adjacent nodes in each DEM node.
In order to specify number of adjacent nodes of DEM, select the Aperture size in the list.
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5. [optional] To apply Gauss smoothing algorithm set the Smooth byGauss checkbox;

6. [optional] Set the Build inside selected polygons checkbox to create a contours
within the selected polygons;

7. [optional] Input minimal elevation level (Zmin), which will be zero-level for contours
creation, to the Starting level field.

In order to obtain information about about elevation difference (Zmin, Zmax), click the DEM
layer by mouse right button in the Manager and select Information. The system displays
the information window that contains information about the layer.

8. In the Interval field specify contours interval in meters. Interval of Basic contours
equals to 1 contours Interval (displayed in the Basic contours field).

9. [optional] To create index contour lines the Index contour lines checkbox is on by
default. Set the checkbox off to cancel index contour lines creation.

The interval of index contour lines equals to five intervals of basic contours by default.
The system allows to set arbitrary interval of index contour lines manually.

10. [optional] To create intermediate contour lines the Intermediate contour lines
checkbox is on by default. Set the checkbox off to cancel intermediate contour lines
creation.

The interval of intermediate contour lines equals to half of basic contours interval by
default. The system allows to set arbitrary interval of intermediate contour linesmanually.

11. [optional] For the additional smoothing of created contours, set the Smoothing
checkbox on and specify a level of smoothing using the slider.

12. [optional] In order to cancel creation of short contours, set the Skip contour lines
shorter than checkbox on and input minimal contour length in meters.

13. Click OK. After that the system starts to create contours in a new layer Contours.

To edit created contours selectWindow › Additional › Contours classifier table.

20. Additional features

20.1. Creating overlap map

For visual analysis of images and strips overlap in a block the program provides a feature
of overlap map creating. After creating of such a map the overlap areas are created as
kind of vector polygons on a new vector layer.
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Perform the following actions to create overlap map:

1. Choose Block › Create overlap map. The Create “heat map” window opens.

Fig. 76. Parameters of overlap map creating

2. Choose elements of a block to be used for overlap map creating: For images or
For strips.

3. [optional] Set on the Paint by overlapmultiplicity checkbox to color overlap areas
depending on overlap multiplicity, i.e. on number of images/strips that fall into the
overlap. When the option is disabled overlap areas are not colored.

4. [optional] Set on the Limit overlap multiplicity checkbox and input number of im-
ages/strips in overlap area, and when the value will be exceeded the fill color will
be not changed.

5. Click OK. A new vector layer containing overlap map is created.

In order to obtain information about number of images that fall to chosen overlap area, al-
locate a part of overlap map and choose theWindow › Objects attributes. You can export
overlap map using the Vectors › Export menu item to choose export format.
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Fig. 77. Overlap map

20.2. Deleting images selectively

The program allows to delete images selectively using specified selection criteria. Per-
form the following actions to do this:

If images were removed from project, the do not remove from the Windows file system.

1. Choose Block › Additional › Delete images selectively.... The Selective delete
images window opens.
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Fig. 78. Setting of images selection criteria for deleting

2. Set on one or more checkboxes to search images by chosen parameters:

• to search images with omega, phi or pitch/roll angles absolute values greater
than specified value (in degrees), set on the “Omega” absolute value, “Phi”
absolute value, Pitch absolute value and Roll absolute value checkboxes
accordingly;

• to search images where not specified projection centers and/or not specified ex-
terior orientation angles set on the No projection center ot No EO angles
checkboxes;

• to search images with projection center hight more or less specified value (in
meters), set on the Projection center Z < or Projection center Z > accordingly;

• to search images with Distance between centers in strip less than specified
value, set on the appropriate checkbox;

• set on the appropriate checkboxes to search images with No GPS time, No in-
terior orientation or No measured triangulation points.
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3. Click the Find images matching criteria button. Images found are shown in the
Search results list.

4. [optional] To cancel deleting image set of the checkbox near to image name in the
Search results section.

5. [optional] Click the View in block layout button to analyse images selection using
block layout. Images selected in the Search results list are highlighted in the block
layout.

6. Click the Delete checked button to delete images selected in the list.

20.3. Import of triangulation points from X-Points

The system provides possibility of import of tie and GCP points coordinates from X-
Points files.

To perform measurements import perform the following actions:

1. Click the Tie points list button or the GCP list button on the Aerial Triangu-
lation tab of the main toolbar. The Triangulation points window opens;

2. Click the button (on the Tie points list tab or on the GCP list tab) of the Trian-
gulation points window (choose Import from X-points option in the drop-down
list). The Input file window opens.

3. Choose triangulation points file *.x-points and click the Open button. The Import
measurements from X-Points format window opens.

Fig. 79. Import measurements from X-Points format

4. When using points import from another project specify the way of matching images
names in the X-Points file and images names in the project:

• By name;

• By code;
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• Use correspondence file.

In order to use correspondence file click the button and select file with filenames.

5. Select actions to be performed in case of coincidence of images/points names in
file with existing images/points names in a project: Replace, Skip, Rename.

6. Click OK. Imported points are added to triangulation points list.

20.4. Batch export of vector objects

The system provides possibility of batch vector objects export to separate files with the
same extension.

To export several vector layers to separate files, perform the following actions:

1. Open some vector layers.

2. Select Vectors › Export › Batch export. The Batch object export window opens.

Fig. 80. Batch object export

3. Click the button to choose destination folder for files export.

4. Select one extension from the list below:

• ASCII;

• ASCII-A;

• CSV;

• DGN;
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• DXF;

• Generate;

• ATLAS_KLT;

• KML;

• LIG;

• MIF/MID;

• PLY;

• Shape;

• Panorama;

5. Set the export parameters, according to the chosen extension.

6. Click OK to export several vector objects to separate files with te same extension.

21. Processing report
The system provides possibility for viewing the results of block processing after auto-
matic tie point measurement in the UAS project and its adjustment.

Processing report contains data on the project’s properties, parameters of automatic
tie point measurement and adjustment, lens calibration, and summary on block errors.

The system allows to create the processing report also for projects of the “Central projection”
type (with lesser amount of data). Creation of block processing reports for projects of “Satellite
scanner imagery”, “Airborne Digital Sensor ADS”, and “VisionMap A3” types (see the “Project
types” section in the “Creating project” User Manual) is not provided.

It is necessary to perform automatic tie point measurement and adjustment before the processing
report creation.

In order to open the processing report choose Orientation › Processing report. The
Report window opens.
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Fig. 81. Processing report

Block processing report contains the following main elements and sections:

• the toolbar with buttons used to perform the following operations:

○ – allows to return to previous view of the report;

○ – allows to refresh results in the report after editing of tie points in the Points
measurement module;

○ – allows to perform a search for information in the report;

○ – allows to save report data to files with *.htm, *.html extensions out of active
profile resources;

○ – allows to save report data to files with *.htm, *.html extensions in active
profile resources;
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○ – allows to print a report;

• the Project properties and initial data section of a report used to view general
statistics (see also the “Project properties” chapter of the “Creating project” User
Manual) and contains the following information:

○ a project name;

○ report generating date.

○ camera data;

○ GSD (Ground Sample Distance) – a pixel size on ground for digital images;

○ project coordinate system;

○ project heights range in meters;

○ area of the in m2;

○ a total number of project strips/images;

○ a number of tie/check/groud control points;

• the Processing parameters section of a report used to view the parameters of
automatic tie point measurement and block adjustment;
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Fig. 82. The “Processing parameters” section

• the Processing results section, containing the following information:

○ Results of camera calibration (see the “Project cameras management” chapter
of the “Aerial triangulation” User Manual).
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Fig. 83. The “Processing results” section

• the Ground control and check points accuracy section of a report used to view
and analyse the block adjustment results (see the “Brief residuals report” chapter of
the “Block adjustment” User Manual) and contains the following tables:

○ Ground control point residuals – adjustment residuals on GC points;

○ Check point residuals – adjustment residuals on check points.
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Fig. 84. The “Ground control and check points accuracy” section

• the Exterior orientation parameters accuracy section of a report used to view re-
siduals on linear and angle exterior orientation parameters (see the “The “Report”
tab” chapter of the “Block adjustment” User Manual);

Fig. 85. The “Exterior orientation parameters accuracy” section
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• Stereopairs residuals – a table containing tie point measurement difference between
stereopairs (see “Brief residuals report” in the “Block adjustment” User Manual).

Fig. 86. The “Stereopair residuals” section

22. Relative orientation report

22.1. Report parameters and output

The program allows to view the results of relative orientation operation after measure-
ment of tie points coordinates. To view and analyse the data, and control accuracy of
relative orientation the program allows to generate a report, that is formed considering
specified parameters of accuracy control, residuals threshold and data output format.

Relative orientation and accuracy control includes the following steps:

• accuracy control for measurements on stereopairs using residual vertical parallaxes;

• accuracy control for measurements in triple overlap zones using discrepancies in tie
points measurements taken on two adjacent stereopairs (models);

• control of tie points number and uniformity of their distribution on stereopairs and in
triplets;
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• control of difference between kappa angle and a block scheme.

It is possible to view the relative orientation report in theAutomatic tie point measure-
ment, Triangulation points windows, and in the Points measurement module after
clicking the button. Prior to the report appearing the Relative orientation report
settings window opens.

When the report is opened in thePointsmeasurementmodule, theRelative orientation
report settingswindow in not opened, and the report is opened only for images opened
in the module considering preset or default parameters. To view and edit the parameters
it is possible to use the link in the report window [Report parameters].

In order to open the relative orientation report perform the following actions:

1. Choose Orientation › Additional › Relative orientation report or click the
button in the toolbar of the Triangulationwindow. TheRelative orientation report
settings window opens. It is used to specify parameters of accuracy control and
format of output results of relative orientation in report.

Fig. 87. Parameters of relative orientation report

2. Select the Main parameters tab (it is selected by default).

3. In the Show report section specify block images to be included to relative orientation
report:

• to view a general report for the whole images block select the for all images
option;
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• to view a report for selected images select the for selected images option;

• to view a report for selected and their adjacent images select the for selected
images option and set the add adjacent images checkbox.

4. In the Stereopairs section specify the following parameters of accuracy control for
points measurements on block stereopairs:

• to check measurements for vertical parallax error select the Check vertical
parallax checkbox and input acceptable threshold value (in pixels or mm) for
selected error type (RMS, mean or maximal error);

It is recommended to set the threshold value of maximal error equal to the pixel size.

• to check discrepancy of kappa angle from block layout set on theCheck discrep-
ancy of kappa angle from block layout checkbox and specify a threshold value
of angles discrepancy in degrees;

It is recommended to specify Angle discrepancy threshold values from 30 to 45 de-
grees.

• to check stereopairs for sufficient measurements number set theCheck number
of tie points checkbox and specify minimal number of tie points per stereopair;

It is recommended to specify Minimal number value not less than 12 point per in-strip
stereopair (2 points per each of 6 standard zones) and at least 2 points per inter-strip
stereopair.

• to check distribution uniformity of tie points on stereopairs set on theCheck point
distribution uniformity checkbox;

There is non-uniform points distribution on a stereopair, if in each of 6 standard zones
a number of points differs more than 2 times from average amount of points in zone.

• to check number of tie points and their distribution uniformity on inter-strip stereo-
pairs set on the Check errors in inter-strip stereopairs checkbox.

The checkbox is cleared by default, since an analysis of points in 6 standard zones for
inter-strip stereopair is not necessary in many cases.

5. In the Triplets section specify the following parameters of accuracy control for
points measurements in triplets:
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• to check measurement errors in triplets set on the Check residuals in triplets
checkbox and input threshold value by XY and by Z (in pix, mm or meters) for
selected residual type (RMS, mean or maximal error);

• to check triplets for sufficient number of measured tie points set the Check
number of tie points checkbox and specify minimal number of points.

It is recommended to specify a Minimal number at least 3 points per each triplet.

6. Open theAdditional tab, that includes sections used to setup data view parameters
in the report.

The Residuals format section is used to setup format of errors numeric values in
the report:

• fixed point – is used to set format of errors numeric values accurate within 3
decimal places;

• exponential – is used to set format of errors numeric values in exponential
notation, where a part of number is replaced with symbols E+n, where E (expo-
nent) means multiplying the preceding number by 10 to the power n.

The Precision section is used to setup output data accuracy, select: normal, high
or maximal.

The Angles section is used to setup angles format in the report:

• Alpha, omega, kappa – angular elements of image exterior orientation (are used
in Russian coordinate systems);

• omega, phi, kappa – angular elements of image exterior orientation (are used
in International coordinate systems (see the “Block adjustment” User Manual)).

The Angle units section is used to setup format of angles measurements units:

• radians;

• degrees;

• gons – plane angle measurement unit that equals to 1/100 of flat right angle
measurement unit, and full angle is 400 gons.
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Fig. 88. Additional report parameters

7. Click OK. The report on relative orientation results is opened. It considers all spe-
cified main and additional parameters (see the Section 22.2).

22.2. Report view and analysis

Report on relative orientation includes results of relative orientation operation, displays
statistics of tie points measurement, and allows to reveal and eliminate errors of points
measurement. The report is generated for all or for selected project images considering
parameters specified in the Relative orientation report settings window.

A feature of relative orientation report is the ability to pass to the Points measurementmodule
directly from the report that allows to eliminate detected measurement errors.

It is possible to view relative orientation report from different windows of the program using the
button. Prior to the report appearing theRelative orientation report settingswindow opens.

When the report is opened from the Points measurement module, the Relative orientation
report settings window is not opened, and the report is shown only for images opened in the
module considering previously set or default parameters. To view and edit the parameters it is
possible to use the link in the report window [Report parameters].
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Fig. 89. Relative orientation report

Relative orientation report contains the following main elements and sections:

• the toolbar with buttons used to perform the following operations:

○ – allows to return to previous view of the report;

○ – allows to refresh relative orientation results in the report after editing of tie
points in the Points measurement module;

○ – allows to perform a search for information in the report;

○ – allows to save report data to files with *.htm, *.html extensions out of active
profile resources;

○ – allows to save report data to files with *.htm, *.html extensions in active
profile resources;

○ – allows to print a report;

• the links in upper part of a report:
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○ jump to [in-strip measurements] – allows to view the points measurements inside
strips;

○ jump to [inter-strip measurements] – allows to view the points measurements
between strips;

○ see also the [interior orientation report] – allows to open report on interior orientation;

○ [Back] – allows to go back to previous report view;

○ [Refresh] – allows to refresh relative orientation results in the report after tie points
editing in the Points measurement module;

○ [Report parameters] – allows to change the parameters and refresh the report;

○ [Unselect all] – allows to cancel data selection in the report;

○ [Top] – allows to go to the report top.

• the Block statistics section of a report used to view general statistics, contains the
following information:

○ a project name;

○ a total number of project strips/images;

○ a number of selected strips/images;

○ report generating date.

• the In-strip measurements section of a report used to view and analyse points
measurements inside strips, contains the following tables:

○ statistics table on in-strip measurements (strips table);

○ table of stereopairs of each strip;

○ table of triplets of each strip.

In inter-strip stereopairs and triplets tables there is a possibility to go to the Points measure-
mentmodule and open images of selected stereopair/triplet automatically, that allows to edit
points measurements there.

• the Inter-strip measurements section of a report used to view and analyse points
measurements between strips, contains the following tables:

○ statistics table on inter-strip measurements;
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○ table of inter-strip stereopairs.

In inter-strip stereopairs tables there is a possibility to open selected stereopair in the Points
measurement module that allows to edit points measurements there.

22.3. The in-strip measurements section

The In-strip measurements section of report is used to view points measurements
results inside a strip and contains the following data:

Fig. 90. The “In-strip measurements” section

• Table of strips (Statistics) contains measurements data inside each strip and includes
the following columns:

○ the Strips column is used to display a strip name in block;

○ the Images column is used to display names of the first and the last images in a
strip;

○ the Total column is used to display a number of stereopairs/triplets in each strip;
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○ the Complete column is used to display a number of stereopairs/triplets with per-
formed relative orientation with errors within specified thresholds;

○ theResiduals column is used to display a number of stereopairs/triplets with errors
exceeding specified thresholds;

○ the Not complete column is used to display a number of stereopairs/triplets for
which relative orientation is not performed.

Yellow color highlight is used if relative orientation inside a strip is performed with
errors.

Strips where there is no relative orientation results are highlighted by red color.

• Table of stereopairs contains points measurements data on stereopairs for each strip
and includes the following columns:

○ the first column is used for points measurements editing and allows to open
thePoints measurement module with images of stereopair selected in the table;

When editing is completed and the Points measurement module is closed, click the
[Refresh] link in the report to re-calculate relative orientation and refresh the report.

○ the Stereopair column is used to display names of images of each stereopair of
a strip;

Click the stereopair link to open detailed report on measurements of selected stereopair
(see the Section 22.5).

○ the Number of points column is used to display a number of points measured on
a stereopair;

○ the Vertical parallax column is used to display a value of vertical parallax for all
measurements on a stereopair (RMS, mean abs. and maximal error) considering
threshold parameters, error type and measurement units specified in the Relative
orientation report settings window;

A row of stereopair with points which coordinates failed to be calculated, is highlighted by
red color, and in the Vertical parallax column the warning message “Coordinates calcu-
lation failed” is displayed with specifying Y-parallax value in brackets.

○ theDiscrepancy of kappa angle column is used to display a value of kappa angles
difference (calculated using block scheme) between images.

○ the Distribution uniformity column is used to display data about uniform or non-
uniform distribution of points on a stereopair;
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A distribution of points on a stereopair is considered as non-uniform, when in any of 6
standard zones, a number of points differs more than twice from average number of points
in zone.

○ the +/- buttons in the last column allow to highlight/cancel highlight of stereopair
on a block scheme in 2D-window for visual estimation of stereopair location in im-
ages block.

A stereopair is highlighted along with adding it to already highlighted ones in 2D-window.
Cancelling of a stereopair highlighting is performed along with “subtraction” from highlighted
stereopairs.

Stereopairs with measurements errors are highlighted by yellow color, stereopairs
with unavailable relative orientation by red color.

The following errors are shown by red color (they are depending on parameters
specified in the Relative orientation report settings window):

○ number of points measured on a stereopair, below specified threshold;

○ values of vertical parallax, exceeding specified threshold;

○ non-uniformity of points distribution;

If there each standard zone contains measurements of coordinates of at least one point,
then a stereopair with measurements errors is highlighted by yellow color.

○ difference of kappa angles, that exceeds specified value.

• Table of triplets displays data on measurements in each triplet of a strip and contains
the following columns:

○ The first column is used for measurements editing and allows to open thePoints
measurement module and to open automatically images of selected triplet at the
same time;

When editing is completed and the Points measurement module is closed, click the
[Refresh] link in the report to re-calculate relative orientation and refresh the report.

○ the Triplet column is used to display names of images of each triplet in a strip;

After clicking the triplet link the detailed report on selected triplet measurements is opened
(see the Section 22.6).

○ the Number of points column is used to display number of points measured on
triplet;
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○ the Tie residuals column is used to display values of tie residuals in triplet by XY
and Z (RMS, mean abs. and max error) considering parameters of threshold, error
type and measurement units specified in the Relative orientation report settings
window.

Triplet errors by ties, exceeding specified thresholds, are highlight by red color.

22.4. The inter-strip measurements section

The Inter-strip measurements section of report is used to view points measurements
results inside a strip and contains the following data:

Fig. 91. The “Inter-strip measurements” section

• The inter-strip ties table (Statistics) displays a number of inter-strip stereopairs for
each pair of adjacent strips and presence of measurement errors during relative ori-
entation operation.

• The inter-strip stereopairs table contains the following columns:

○ the first column is used to edit points measurements and allows to open the Points
measurementmodule and to open automatically at the same time images of inter-
strip stereopair selected in the table;

When editing is completed and the Points measurement module is closed, click the
[Refresh] link in the report to re-calculate relative orientation and refresh the report.
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○ the Stereopair column is used to display names of images of each inter-strip ste-
reopair;

After clicking the inter-strip stereopair link the detailed report on selected stereopair
measurements is opened (see the Section 22.4).

○ the Number of points column is used to display a number of points measured on
inter-strip stereopair;

○ the Vertical parallax column is used to display a value of vertical parallax for all
measurements on a inter-strip stereopair (RMS, mean abs. and maximal error)
considering threshold parameters, error type and measurement units specified in
the threshold parameters;

○ theDiscrepancy of kappa angle column is used to display a value of kappa angles
difference (calculated using block scheme) between images.

○ the Distribution uniformity column is used to display data about uniform or non-
uniform distribution of points on a inter-strip stereopair.

○ the last columns allows to highlight a stereopair (+) or cancel the highlighting of a
stereopair (–) in 2D-window that allows to estimate visually whether the stereopair
is located within images block.

A stereopair is highlighted along with adding it to already highlighted ones in 2D-window.
Cancelling of a stereopair highlighting is performed along with “subtraction” from highlighted
stereopairs.

If in the Relative orientation report settings window the Check errors in interstrip
stereopairs checkbox is set, then the errors in the report are highlighted in the following
way: yellow color shows strips and stereopairs that contain points measurements ex-
ceeding threshold, and the errors values are shown by red color.

22.5. The stereopair measurements section

Relative orientation report provides possibility to view a detailed report on any selected
stereopair that contains data on tie points measurements, calculated relative orientation
parameters, information about kappa angles difference and uniformity of tie points dis-
tribution on a stereopair. A detailed report allows to perform control of measurement
accuracy of common points of a stereopair images by values of vertical parallax resid-
uals. To view detailed report for selected stereopair click the stereopair hyperlink in the
tables of in-strip and inter-strip stereopairs.
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Fig. 92. Detailed report for selected stereopair

Detailed report on selected stereopair includes the following data:

• hyperlinks of detailed report:

○ [Relative orientation report] – the link is used to return to the first page of the
common report on in-strip and inter-strip measurements;

○ [Back] – the link is used to return to previous view of detailed report on stereopair
measurements;

○ [Refresh] – allows to refresh relative orientation results in the report after tie points
editing in the Points measurement module;

○ [Report parameters] – the link is used to change the report parameters and to re-
fresh the report;

○ [Edit] – the link is used to view and edit measurements on a stereopair in the Points
measurement module;

○ [Select stereopairs] – allows to select a stereopair on a block scheme in 2D-window;

○ [Unselect stereopairs] – allows to unselect a stereopair on a block scheme in 2D-
window;
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○ [Unselect all] – allows to unselect all previously selected stereopairs.

• information about number of measured tie points on a stereopair;

• the Vertical parallax table contains the following columns:

○ the first column is used to edit selected tie point and allows to open the Points
measurement module and to open at the same time images of the stereopair
automatically and place marker on selected point;

After the point editing is completed and the Points measurement module is closed click
the [Refresh] hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Point column displays names of tie points;

○ the Number of points column is used to display a number of points measured on
inter-strip stereopair;

○ the Image ... (left) column displays a value of vertical parallax residual on the left
image of stereopair (in mm and pix);

○ the Image ... (right) column displays a value of vertical parallax residual on the
right image of stereopair (in mm and pix).

In the threshold row the threshold for vertical parallax residual is displayed in accord-
ance with specified value, measurements units and residual type (RMS, Mean abs.
and max error) of the Vertical parallax threshold parameter in the Relative orient-
ation report settings window.

At the bottom of the table there are final values of vertical parallax residual on all
measurements of the stereopair (RMS, Mean abs. and max error). The program
performs control of threshold exceeding only for error type specified in the Relative
orientation report settings window.

Values of vertical parallax residuals exceeding specified threshold, are highlight by
red color.

• theRelative orientation parameters table contains values of calculated relative orient-
ation angles for the left and right images according to selected angular system and
measured units on the Additional tab in the Relative orientation report settings
window;

• theOrientation 2D (by block scheme) andDiscrepancy of kappa angles tables contain
values of kappa angles;

Accuracy control of kappa angles discrepancy between images is performed if in theRelative
orientation report settings window the appropriate checkbox is set and a threshold value
for kappa angles discrepancy is specified.
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• the Distribution uniformity tables contain information about uniformity of points distri-
bution over standard zones. To estimate the parameter the system analyses a differ-
ence of points number in each of 6 standard zones.

Control of points number and uniformity of their distribution on stereopair’s zones is performed
if corresponding parameters are specified in theRelative orientation report settingswindow.

22.6. The triplet measurements section

Relative orientation report provides possibility to view a detailed report on selected
triplet. A detailed report for a triplet is used to view and perform accuracy control of
measurements in triplet by tie points errors. In order to view a detailed report on selected
triplet click the triplet link in the triplets table of the Inter-strip measurements section
of the report (see the Section 22.3).

Fig. 93. Detailed report for selected triplet

Detailed report on selected triplet includes the following data:

• hyperlinks of detailed report:

○ [Relative orientation report] – the link is used to return to the first page of common
report on relative orientation;
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○ [Back] – the link is used to return to previous view of detailed report on measure-
ments in triplet;

○ [Refresh] – allows to refresh relative orientation results in the report after tie points
editing in the Points measurement module;

○ [Report parameters] – the link is used to change the report parameters and to re-
fresh the report;

○ [Edit] – the link is used to view and edit a triplet measurements in the Points
measurement module;

○ [Stereopairs] – two links used to proceed to detailed measurements report of points
on stereopairs, that form the triplet (see the Section 22.5).

• information about number of measured tie points in a triplet;

• the Tie residuals table contain the following columns:

○ the first column is used to edit selected tie point and allows to open the Points
measurement module and to open automatically at the same time triplet images
and to place marker on selected point;

After the point editing is completed and the Points measurement module is closed click
the [Refresh] hyperlink in the report to re-calculate relative orientation and refresh the report.

○ the Point column is used to display a tie point name;

○ the Ex, Ey, Ez, Exy columns – tie residuals by X, Y, Z axes and tie residual by
(XY) in measurement units specified for residuals control in triplet in the Relative
orientation report settings window.

In the threshold row there is a triplet residual threshold according to specified value,
measurement units and error type (RMS, Mean abs. and max error) of the Triplet
residuals threshold parameter in theRelative orientation report settingswindow.

At the bottom of the table final values of tie residuals on all triplet measurements are
shown (RMS, Mean abs. and max error). Accuracy control is performed only for the
residual type that is specified for the Triplet residuals threshold parameter in the
Relative orientation report settings window.

Values of tie errors that exceed specified threshold are highlighted by red color.
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23. Distributed Processing

23.1. General Information

Program includes capability of distributed processing of some tasks. This helps achieve
maximum utilization of hardware resources for carrying out large projects.

Distributed tasks processing is a capability of parallel task execution with multiple pro-
cessor cores or multiple computers in local network.

The program provides an opportunity only local distributed processing with using several cores
of one computer.

Computers participating in the distributed processing are assigned the three following
modes:

• Server is the control center of the distributed processing, responsible for distribution
of tasks and synchronization of Сlient computers;

• Client is a computer, which receives tasks to process from the Server;

Each Client must be connected to the Server.

• Monitor is a computer, where the distributed processing control center is launched
and the Monitor for distributed processing window is opened to observe task
processing.

To launch the Distributed processing control center perform one of the following:

• in context menu of System Monitor modulechoose the Distributed processing
control center;

The Start automaticallymenu item allows to launch the distributed processing control center
automatically concurrently with launching any module of program when System Monitor
module is also launched.

• choose the Service › Additional › Distributed processing › Control centre.

The distributed processing control center is launched with properties of previous working
session of program in the Windows system tray the icon displays. During the first
launch the Distributed processing setup window is also opens.

The distributed processing icon in the Windows system tray is different depending on
using computer in the distributed processing mode:
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• – Server and Client are not launched (computer is not used in distributed pro-
cessing);

• – Server connection fault;

• – only Server is launched;

• – Server and Client are launched;

• – only Client is launched, connection to Server.

23.2. Workflow of distributed processing

The following work flow is used to distributed tasks processing:

1. Launch the Distributed processing control center.

2. Choose the computer as a Server and Client of distributed processing.

3. Choose not-used Port for incoming connections.

4. Setup parameters of distributed processing task and click OK. The list of distributed
processing task is created and displayed in the Tasks table.

5. Open the Monitor for distributed processing.

6. Choose the task for processing in the Task section.

7. Choose the computer as a Client to process chosen task in theComputers section.

8. [optional] Click the button to perform all distributed processing task automatically.

9. Click the button on the Tasks section toolbox to start distributed processing.

Each next task start with lagged on some seconds.

23.3. Distributed processing parameters setup

The Distributed processing setup window is used to setup distributed processing
parameters.
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Fig. 94. Distributed processing parameters setup

The program provides an opportunity only to use local computer for distributed pro-
cessing tasks with using several cores of one computer, i.e. using computer as a
Server and Client at the same time.

Perform the following actions to do this:

1. Set on the Distributed processing server checkbox.

2. Set free port in the Port for incoming connections field.

If not possible to connect with chosen port, choose another one.

3. Set on theDistributed processing client checkbox. Server name and port number
are set automatically.

4. [optional] Set on the Maximal number of tasks, which are process of each Client
at the same time. By default the value is equal to number of cores or processors
of computer.

5. Click OK. During the first setup the Monitor of distributed processing window
opens and in theWindows system tray the icon of distributed processing is displayed.

It is necessary to restart the distributed processing control center if parameters were
changed.

Also there is an opportunity to detail setup of distributed processing parameters. Click
the More button of the Distributed processing setup window to do that.

It is strongly not recommended to change default parameters in the e Distributed processing
setup window.
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Fig. 95. Additional distributed processing parameters

The following parameters are available to setup:

• Task start interval, ms – allows to change the delay time between starting tasks;

• Number of task to start simultaneously – allows to change the number of tasks
which are processing in the same time by distributed processing clients;

• Number of attempts to start in case of the task runtime errors – allows to change
number of attempts ta start the task if there is an error;

It is reccommended to change the value in case of non-stable network or breaks in electricity
supply, etc.

○ Min\max – range of restart attemps;

○ by number of clients – by default the restart attemps number is equal to number
of connected distributed processing Clients.

• Enable server/client debug log – allows to create a log-file with information about
distributed processing (to sent files in technical support during solving problems of
Server/Client connection only).

Set on the Enable server/client debug log checkboxes may cause to reducing stability of
program’s work.

It is strongly not recommended to set on the Enable server/client debug log checkboxes.

23.4. Distributed processing management

The Monitor of distributed processing window is used for condition monitoring of
distributed processing. The window opens automatically after setup distributed pro-
cessing parameters.

Also the menu item Start monitor of context menu of the distributed processing icon
and the Service › Additional › Distributed processing › Monitor menu items.
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While theMonitor of distributed processingwindow opens, theMonitor status adds to computer
also.

Fig. 96. Monitor for distributed processing

In the Monitor of distributed processing window displays information about tasks
queue and Clients computers using. The window also allows to manage tasks pro-
cessing.

The window refresh automatically each several seconds.

The Tasks containts toolbar and table with information about tasks. The table consists
of columns with following information:

• ID – unique identifier for each task;

• State – the status of the task:

○ waiting;

○ paused;

○ performed – in this case shows the percentage of task completion;

○ complete;

○ failed – displayed in case of complete part or resource connection error (marks
yellow);
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○ not complete (marks red) – displayed in case of tasks didn’t complete because of
Client was disconnected during the task processing, Server was disconnected or
task was cancelled.

• Priority – priority of the tasks (integer, the larger the number, the higher the priority,
the tasks of higher priority are performed in the first place);

• Name – type of task and number in tasks list;

• Created at – the date and time of posting task;

• Started at – the data and time are displayed for started task;

• Executor – for started task – the name of Client computer, which executes it;

• Est. time left – the approximate time before complete processing tasks

• Profile – active Client profile at the time of posting of tasks. This profile must be
network and connected to other Clients in order that they have been able to execute
the tasks.

Points sorting in columns of the list is performed by mouse click on the column header.

If during the task execution an error occurs on any of network computers, it’s highlighted
in yellow in the list. In this case attempts will be made to perform the same tasks on
other computers. The task will remain in the queue with a Failed state until it is deleted
manually, if no computer in network is able to execute this task.

Table 21. The Tasks section toolbar

FunctionButtons
allows to start selected tasks sequentially
allows to pause selected tasks
allows to stop selected tasks
allows to reset selected tasks state (the Waiting
caption appears in the State field)
allows to set on the auto run tasks – automatic dis-
tribution of tasks in the queue (according to priority)
between the Clients and launch of the tasks
allows to increase priority of selected tasks by 1
allows to decrease priority of selected tasks by 1
allows to remove selected tasks from the queue
allows to remove complete tasks from the queue
allows to clear the queue of tasks
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The Computers section contains the table of computers, which are currently in the
network and configured with the same Server.

The table contains following parameters for each computer:

Points sorting in columns of the list is performed by mouse click on the column header.

• Name – shows network computer name;

• IP-address – IP-address of the computer;

• Type – Client or Monitor;

• Current tasks – tasks number of distributed processing, which currently performed
by Client;

• Core quantity – the total quantity of Client CPU’s cores;

• Max tasks – the maximum quantity of simultaneously running tasks specified during
the Client configuration;

Maximum quantity of tasks are less than or equal to the number of CPU’s cores of computer.

• PHOTOMOD version – the PHOTOMOD build number for control of compatibility.

It is recommended to use the same PHOTOMOD build on all computers working with the
same Synchronization folder.

In the case if the computer is disconnected from the distributed processing, it’s high-
lighted in red in the table.

To perform actions with multiple computers, select them in the table using Shift and Ctrl keys.

Table 22. The Computers section toolbar

FunctionButtons
allow selected computers to execute new tasks (if forbidden)
forbid selected computer to execute new tasks When current task complete, Client go to sleep
mode and doesn’t start new tasks temporary
increase maximum number of simultaneously running tasks by 1
decrease maximum number of simultaneously running tasks by 1
hide disconnected computers (highlighted in red)
display all connected and disconnected Client computers in the table
display all connected and disconnected Monitor computers in the table
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